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1本マニュアルについて 

1.1 マニュアルの内容 

このマニュアルは、主に Gowinソフトウェアのインストールと操作

について説明し、ユーザーが Gowinソフトウェアを使いこなせるように

作成されています。本マニュアルに記載のソフトウェア GUIのスクリー

ンショットは、Gowinソフトウェア V1.9.11.03バージョンの場合のもの

です。ソフトウェアのアップデートにより、一部の内容が変更される場合

があります。 

1.2 関連ドキュメント 

GOWINセミコンダクターのホームページ www.gowinsemi.com/jaか

ら、以下の関連ドキュメントをダウンロード及び閲覧できます。 

 Gowinタイミング制約ユーザーガイド(SUG940) 

 Gowin物理制約ユーザーガイド(SUG935) 

 Gowinアナライザオシロスコープ ユーザーガイド(SUG114) 

 Gowinパワーアナライザ ユーザーガイド(SUG282) 

 Gowin Programmerユーザーガイド(SUG502) 

 Gowin BSRAM & SSRAMユーザーガイド(UG285) 

 Gowinプリミティブ ユーザーガイド(SUG283) 

 Gowin Clockユーザーガイド(UG286) 

 Gowin DSPユーザーガイド(UG287) 

 Gowinプログラマブル汎用 IO(GPIO)ユーザーガイド(UG289) 

 Gowin User Flashユーザーガイド(UG295) 

 Arora V ADCユーザーガイド(UG299) 

 Arora V Clockユーザーガイド(UG306) 

 Arora V DSPユーザーガイド(UG305) 

https://www.gowinsemi.com/ja
http://cdn.gowinsemi.com.cn/SUG940J.pdf
http://cdn.gowinsemi.com.cn/SUG935J.pdf
http://cdn.gowinsemi.com.cn/SUG114J.pdf
http://cdn.gowinsemi.com.cn/SUG282J.pdf
http://cdn.gowinsemi.com.cn/SUG502J.pdf
http://cdn.gowinsemi.com.cn/UG285J.pdf
http://cdn.gowinsemi.com.cn/SUG283J.pdf
http://cdn.gowinsemi.com.cn/UG286J.pdf
http://cdn.gowinsemi.com.cn/UG287J.pdf
http://cdn.gowinsemi.com.cn/UG289J.pdf
http://cdn.gowinsemi.com.cn/UG295J.pdf
http://cdn.gowinsemi.com.cn/UG299J.pdf
http://cdn.gowinsemi.com.cn/UG306J.pdf
http://cdn.gowinsemi.com.cn/UG305J.pdf
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 Arora Vプログラマブル汎用 IO(GPIO)ユーザーガイド(UG304) 

 Arora V BSRAM & SSRAMユーザーガイド(UG300) 

 Arora Ⅴ物理制約ユーザーガイド(SUG1018) 

 Gowin Virtual Input Outputツール ユーザーガイド(SUG1189) 

 Gowin GoBertツール ユーザーガイド(SUG1198) 

1.3 用語、略語 

本マニュアルで使用される用語、略語、及びその意味を表 1-1に示し

ます。 

表 1-1用語、略語 

用語、略語 正式名称 意味 

CRC Cyclic Redundancy Check 巡回冗長検査 

FloorPlanner FloorPlanner 物理制約エディタ 

FPGA Field Programmable Gate Array 

フィールド・プログラ

マブル・ゲート・アレ

イ 

GAO Gowin Analyzer Oscilloscope 
Gowinアナライザオシ

ロスコープ 

GowinSynthesis GowinSynthesis  
GOWINセミコンダクタ

ーの合成ツール 

GPA Gowin Power Analyzer 
Gowinパワーアナライ

ザ 

GVIO Gowin Virtual Input/Output 仮想入力出力 

IP Core Intellectual Property Core 設計資産コア 

PCIe 
Peripheral Component 
Interconnect Express 

ペリフェラル・コンポ

ーネント・インターコ

ネクト・エクスプレス 

PnR Place & Route 配置配線 

Schematic Viewer Schematic Viewer HDL回路図ビューア 

SEU Handler Single-Event Upsets Handler 

シングル・イベント・

アップセット・ハンド

ラ 

Tcl Tool Command Language ツール・コマンド言語 

Timing Constraints 
Editor 

Timing Constraints Editor 
タイミング制約エディ

タ 

http://cdn.gowinsemi.com.cn/UG304J.pdf
http://cdn.gowinsemi.com.cn/UG300J.pdf
http://cdn.gowinsemi.com.cn/SUG1018J.pdf
http://cdn.gowinsemi.com.cn/SUG1189J.pdf
http://cdn.gowinsemi.com.cn/SUG1198J.pdf
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1.4 テクニカル・サポートとフィードバック 

GOWINセミコンダクターは、包括的な技術サポートをご提供してい

ます。使用に関するご質問、ご意見については、直接弊社までお問い合わ

せください。 

ホームページ：www.gowinsemi.com/ja 

E-mail：support@gowinsemi.com 

https://www.gowinsemi.com/ja
mailto:support@gowinsemi.com
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2Gowinソフトウェアの概要 

2.1 概要 

Gowinソフトウェアは、Gowin FPGA用に特別に設計された、FPGA

設計および検証環境を提供する EDAソフトウェアです。Gowin FPGAの

低消費電力と低コスト特性のために最適化された Gowinソフトウェア

は、RTL回路機能の記述から FPGAビットストリームファイルの生成ま

でのプロセス全体に対応すると同時に、最適化設計、自動設計、グラフィ

ック・インタラクティブ・デザインなどの機能を備えた、高性能で使いや

すい EDAソフトウェアです。 

Gowinソフトウェアの主な機能： 

 Gowin FPGAのすべての機能をサポートし、RTL回路機能の記述から

FPGAビットストリームファイルの生成までの設計フローをサポート 

 合成ツール GowinSynthesisは、高性能のロジック設計と合成をサポ

ート 

 自動デザインとインタラクティブなグラフィック・デザインの併用を

サポート 

 Centos6.8/7.0/7.3/7.5/8.2(64 bits)、Ubuntu18.04/20.04LTS、

Win7/8/10/11(32 bits/64 bits)、Win XP (32 bits)オペレーティングシス

テムをサポート 

 千万規模のゲートレベルのソフトウェア 

 VHDL、Verilog HDL、および SystemVerilog言語をサポート 

 Gowin FPGAの最適化されたアーキテクチャをサポート 

 オリジナルの高速で高性能なアルゴリズムを備えた配置配線システム 

 正確なタイミング解析とタイミングレポート 

 クロックの分析と制御により、より良いタイミングパフォーマンスを

提供 

 さまざまなタイミング制約と物理制約をサポート 
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 ハードウェア回路信号をリアルタイムで監視して保存し、タイミング

波形図に視覚的に表示することをサポート 

 リソース共有テクノロジーにより、チップの使用率を向上させ、コス

トを削減 

Gowinソフトウェアの主な特徴： 

 統合設計 

- 設計は段階的に完了することも、一括自動的に完了することも可

能 

- コマンド・ライン・モードと GUIモードをサポート 

- スクリプト設計により、設計プロセス全体に影響を与えることな

く、単一のモジュールを柔軟に設計可能 

 最適化設計 

- ネットリストの最適化設計 

- 高速のタイミングの最適化解析と設計 

- リソースの分析と最適化 

 階層的な設計と分析 

- 階層的なネットリスト構造入力および出力をサポート 

- フラット化ネットリストの入力および出力をサポート 

- ネットリストの階層的なグラフィック表示、追跡、および分析を

サポート 

 便利で柔軟なインタラクティブ・グラフィックデザイン 

- シンプルで明確な GUI 

- プロジェクト、設計モジュール、ツール、および出力などの要素

を含む 

- 設計制約の入力、選択、更新 

- 高速のタイミング解析とレポート 

- Push button設計手法 

2.2 サポートされるデバイス 

Gowinソフトウェアは現在、LittleBeeファミリーと Aroraファミリ

ーの FPGA製品をサポートしています。FPGAのタイプ、主なリソー

ス、およびパッケージについては、Gowinのホームページを参照してく

ださい。 

 LittleBeeファミリー：https://www.gowinsemi.com/ja/product/detail/2/ 

 Aroraファミリー：https://www.gowinsemi.com/ja/product/detail/1/ 

https://www.gowinsemi.com/ja/product/detail/2/
https://www.gowinsemi.com/ja/product/detail/1/
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 Arora V FPGA：https://www.gowinsemi.com/en/product/detail/60/ 

注記： 

ソフトウェアのバージョンによって、サポートされるチップが異なる場合がありま

す。 

2.3 Gowinソフトウェアのインストールと起動 

Windowsでは、Gowinソフトウェアのインストールパッケージをダ

ブルクリックしてインストールします。インストールが完了すると、デフ

ォルトで PCのデスクトップにショートカットが作成されます。Linuxで

は、フォルダを解凍してソフトウェアをインストールします。 

ソフトウェアのインストール後、最初の起動時にライセンスを構成す

る必要があります。ライセンスは、GOWINセミコンダクターとユーザー

が署名した標準契約であり、ソフトウェアユーザーのソフトウェア使用の

権利と GOWINセミコンダクターの義務を規定します。 

注記： 

Gowinソフトウェアのインストールは、漢字のあるパスをサポートしません。

Gowinソフトウェアのインストールについては、『Gowinソフトウェアクイックイン

ストール ユーザーガイド(SUG501)』を参照してください。 

https://www.gowinsemi.com/en/product/detail/60/
http://cdn.gowinsemi.com.cn/SUG501J.pdf
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3Gowinソフトウェアの GUI 
図 3-1に示すように、Gowinソフトウェアの GUIは主に、タイトル

バー、メニューバー、ツールバー、プロジェクト管理エリア(Design)、プ

ロセス管理エリア(Process)、ソースファイル編集エリア、階層表示エリ

ア(Hierarchy)、インフォメーション出力エリア、および Tclコマンド編集

エリアで構成されています。 

図 3-1ソフトウェアの GUI 
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① タイトルバー ② メニューバー 

③ ツールバー 
④ プロジェクト

管理エリア 

⑤ ソースファイル編

集エリア 

⑥ プロセス管理

エリア 

⑦ 階層表示エリア  ⑧ インフォメー

ション出力エ

リア 

⑨ Tcl コマンド編集エ

リア 

 

3.1 タイトルバー 

Gowinソフトウェアの名前と現在開いているファイルの名前が示され

ます。 

3.2 メニューバー 

File、Edit、Project、Tools、Window、Helpなどがあります。詳細は

次のとおりです。 

3.2.1 Fileメニュー 

 Open Example Project…：サンプルプロジェクトを開く 

 New（Ctrl+N）：新規作成 

 Open（Ctrl+O）：開く 

 Save（Ctrl+S）：保存 

 Save As…：別名で保存 

 Save All（Ctrl+Shift+S）：すべてのファイルを保存 

 Close：閉じる 

 Close All：すべてのファイルを閉じる 

 Close Project：現在のプロジェクトを閉じる 

 Print Preview…：印刷プレビュー 

 Print…（Ctrl+P）：印刷 

 Recent Files：最近開いたファイルを再度選択して開く 

 Recent Projects：最近開いたプロジェクトを再度選択して開く 

 Exit：ソフトウェアを終了 

3.2.2 Editメニュー 

 Undo（Ctrl+Z）：取り消し 

 Redo（Ctrl+Y）：やり直し 

 Cut（Ctrl+X）：切り取り 
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 Copy（Ctrl+C）：コピー 

 Paste（Ctrl+V）：貼り付け 

 Select All（Ctrl+A）：すべて選択 

 Find & Replace（Ctrl+F）：キーワード検索及び変更 

 Toggle Comment Selection（Ctrl+/）：選択された内容にコメントを追

加 

 Increase Indent（Tab）：インデントを増やす 

 Decrease Indent（Shift+Tab）：インデントを減らす 

 Macros：マクロ。このオプションには 3つのサブオプションがあり

ます。 

- Start Record：[Start Record]をクリックすると、IDEで編集可能

なファイルに対する編集操作が記録されます。 

- Stop Recording：記録を停止します。 

- Play Macro（Alt+R）：[Play Macro]をクリックして、編集可能なフ

ァイルに対して記録された操作を実行します。 

3.2.3 Projectメニュー 

 Archive Project：プロジェクトをアーカイブ 

 Restore Archived Project：アーカイブされたプロジェクトを復元 

 Set Device：現在のプロジェクトのデバイス情報を設定 

 Configuration：構成画面を開く 

 Design Summary：現在のプロジェクトに関する情報の詳細を表示 

3.2.4 Toolsメニュー 

 Start Page：スタートページ。Recent Projects、Quick Start、Tools、

および User Manualsが含まれます。 

- Recent Projects：最近開いたプロジェクトのリスト(最大 10個の

プロジェクト)。 

- Quick Start：New Project、Open Project、Open Example Project

が含まれます。 

- Tools：Floorplanner（物理制約エディタの起動）、Timing 

Constraints Editor（タイミング制約エディタの起動）、

Programmer（プログラマの起動）が含まれます。 

- User Manuals：Manual for LittleBee（LittleBeeファミリーのマニ

ュアル）、Manual for Arora（Aroraファミリーのマニュアル）が

含まれます。 

 Gowin Analyzer Oscilloscope：Gowinアナライザオシロスコープ(つ
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まり、ロジック・アナライザー)。 

 Schematic Viewer：HDL回路図ビューア。 

 IP Core Generator：IP Coreジェネレーター。 

 Programmer：プログラマ。 

 FloorPlanner：物理制約エディタ。 

 Timing Constraints Editor：タイミング制約エディタ。 

 DSim：シミュレーションと検証のクラウド・プラットフォーム。 

 GoBert：SerDes分析ツール。 

 Options：Environment、Text Editor、External Editorが含まれます。 

- Environment：Theme(表示モード)、Language(言語）、Toolbar 

Icon Size（ツールバー・アイコン・サイズ）、Default New Project 

Directory(デフォルトの新規プロジェクトのパス)などの IDEパラ

メータを設定します。表示モード(Theme)には、従来モード

(Classic)と夜間モード(Dark)の 2つのオプションがあります。表

示モードまたは言語を設定した後、その設定を有効にするには、

Gowinソフトウェアを再起動する必要があります。 

- Text Editor：フォント、フォント・サイズ、配色、行番号を表示

するかどうか、空白文字を視覚化するかどうか、現在の行をハイ

ライト表示するかどうか、一致する括弧をハイライト表示するか

どうかなど、テキストエディタの属性を設定します。 

- External Editor：サードパーティのテキストエディタを設定しま

す。常にサードパーティのエディタを使用して設計ファイルを開

くかどうかを選択できます。 

3.2.5 Windowメニュー 

 Full Screen（F11）：フルスクリーン表示。 

 Tile：タイル表示。 

 Cascade：カスケード表示。 

 Reset Layout：初期設定に戻す。 

 Panels：インターフェースの各エリアで表示される部分を選択。 

Design、Hierarchy、Process、Message、および Consoleがありま

す。 

 Start Page：ソースファイル編集エリアで Start Pageを表示。 

 Design Summary：ソースファイル編集エリアで Design Pageを表

示。このページには、Generalと Target Deviceの 2つのコンテンツ

が含まれています。詳細は次のとおりです。 

- General：プロジェクトパス情報や使用される合成ツールなど、
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プロジェクトの概要情報。 

- Target Device：パッケージ情報、スピードグレード、コア電圧な

どのデバイス情報。 

3.2.6 Helpメニュー 

 View Help：ソフトウェアのコンパイル中の出力情報のヘルプドキュ

メントを見る。 

 Contact Us：お問い合わせ。 

 Manage License：ライセンスの管理。ライセンス構成管理方法の詳

細については、『Gowinソフトウェアクイックインストール ユーザー

ガイド(SUG501)』を参照してください。 

 About：ソフトウェアのバージョン情報。 

3.3 ツールバー 

一般的に使用されるいくつかの機能のボタンがあります。左から右

へ： 

 「 」（Ctrl+N）：ファイルまたはプロジェクトを新規作成(New File 

or Project) 

 「 」：（Ctrl+O）：ファイルまたはプロジェクトを開く(Open File or 

Project) 

 「 」（Ctrl+S）：ファイルを保存（Save） 

 「 」（Ctrl+Shift+S）：すべてのファイルを保存（Save All） 

 「 」（Ctrl+P）：印刷（Print） 

 「 」（Ctrl+Z）：取り消し（Undo） 

 「 」（Ctrl+Y）：やり直し（Redo） 

 「 」（Ctrl+X）：切り取り（Cut） 

 「 」（Ctrl+C）：コピー（Copy） 

 「 」（Ctrl+V）：貼り付け（Paste） 

 「 」（Ctrl+F）：検索（Find） 

 「 」：Gowinアナライザオシロスコープ(Gowin Analyzer 

Oscilloscope)を起動。詳しくは、『Gowinアナライザオシロスコープ 

ユーザーガイド(SUG114)』を参照してください 

 「 」：IP Coreジェネレーター（IP Core Generator）を起動 

 「 」：プログラマ（Programmer）を起動。詳しくは、『Gowin 

http://cdn.gowinsemi.com.cn/SUG501J.pdf
http://cdn.gowinsemi.com.cn/SUG114J.pdf
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Programmerユーザーガイド(SUG502)』を参照してください 

 「 」：シミュレーションと検証のクラウド・プラットフォーム

(DSim)を起動 

 「 」：アイ・ダイアグラム分析ツールを起動 

 「 」：物理制約エディタ（FloorPlanner）を起動。詳しくは、

『Gowin物理制約ユーザーガイド(SUG935)』を参照してください 

 「 」：タイミング制約エディタ（Timing Constraints Editor）を起

動。詳しくは、『Gowinタイミング制約ユーザーガイド(SUG940)』を

参照してください 

 「 」：合成を実行（Run Synthesis） 

 「 」：配置配線を実行（Run Place & Route） 

 「 」：合成、配置配線を実行（Run All） 

3.4 プロジェクト管理エリア(Design) 

プロジェクト及びその関連ファイルの管理と表示機能を提供します。

プロジェクトで使用されるデバイス情報、設計ファイル、制約ファイル、

構成ファイルなどを表示または編集できます。 

3.5 プロセス管理エリア(Process) 

ユーザーの FPGA設計フローを表示します。これには合成

(Synthesize)、配置配線(Place & Route)、デバイスのプログラミング

(Programmer)が含まれます。また、タイミング制約と物理制約ツールを

ダブルクリックして、制約ファイルを編集することができます。 

3.6 設計階層表示エリア(Hierarchy) 

設計ファイルを読み込んだ後、Gowinソフトウェアはまず設計ファ

イルを解析し、Hierarchyウィンドウに現在のプロジェクトの設計階層を

表示します。Hierarchyウィンドウを介して、モジュールの定義とインス

タンスの場所を特定することができ、モジュールをトップ・モジュールと

して設定することもできます。Hierarchyウィンドウでは、Unit列には設

計ファイルのモジュール階層、Files列にはモジュール定義があるファイ

ルが表示されます。さらに、Hierarchyウィンドウでは、モジュール名ま

たはファイル名でプロジェクトの設計ファイルを検索することができま

す。Hierarchyは現在、Verilog言語、VHDL言語、および System Verilog

言語の解析をサポートしています。 

3.6.1 右クリックメニュー 

Hierarchyウィンドウのモジュールの右クリックメニューで現在サポ

ートされている機能： 

http://cdn.gowinsemi.com.cn/SUG502J.pdf
http://cdn.gowinsemi.com.cn/SUG935J.pdf
http://cdn.gowinsemi.com.cn/SUG940J.pdf
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 Goto Module Instantiation：ソースファイル内のこのモジュールのイ

ンスタンスの場所にジャンプします。デフォルトでは、Gowinソフト

ウェアが提供するエディタで開きます。メニューバーの Tools > 

Options > External Editorでサードパーティのエディタが構成されて

いて、「Always Use External Editor」がチェックされている場合、

Goto Module Instantiationは、デフォルトでサードパーティのエディ

タを使用してソースファイルを開きます。 

 Goto Module Instantiation With ...：ソースファイル内のこのモジュー

ルのインスタンスの場所にジャンプします。右クリックメニューに設

定されたサードパーティのエディタと「Add External Editor」が提供

されます(図 3-2)。「Add External Editor」を選択すると、「External 

Editor」の Optionsダイアログボックスが表示され、サードパーティ

のエディタを設定できます。 

 Goto Module Definition：ソースファイル内のこのモジュールの定義の

場所にジャンプします。デフォルトでは、Gowinソフトウェアが提供

するエディタで開きます。メニューバーの Tools > Options > External 

Editorでサードパーティのエディタが構成されていて、「Always Use 

External Editor」がチェックされている場合、Goto Module Definition

は、デフォルトでサードパーティのエディタを使用してソースファイ

ルを開きます。 

 Goto Module Definition With…：ソースファイル内のこのモジュール

の定義の場所にジャンプします。右クリックメニューに設定されたサ

ードパーティのエディタと「Add External Editor」が提供されます(図

3-2)。「Add External Editor」を選択すると、「External Editor」の

Optionsダイアログボックスが表示され、サードパーティのエディタ

を設定できます。 

 Pack User Design：モジュールとそのサブモジュールを暗号化しま

す。 

 Set As Top Module：このモジュールをトップ・モジュールとして設

定します。トップに設定されたモジュールには、現在のモジュールが

トップ・モジュールであり、元の階層が変更されていないことを示す

マーク「 」が追加されます。 

 Clear Top Module：モジュールのトップ・モジュール設定をクリアし

ます。 

図 3-2 Hierarchyウィンドウでの右クリックメニュー 
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プロジェクトファイルの hierarchy分析中に error情報がある場合

は、赤いフォントでマークされる「RTL Analysis Error」メッセージが

Hierarchyウィンドウの右上に表示されます。このメッセージをクリック

すると、エラー情報の詳細を含むプロンプトボックスがポップアップ表示

されます。 

3.6.2 リソース情報の表示 

合成が完了すると、Hierarchyウィンドウに現在のプロジェクトのリ

ソース情報が自動的に表示されます(図 3-3)。モジュールが暗号化されて

いる場合、そのリソース情報は表示されません。暗号化モジュールのリソ

ース情報はその上位層モジュールにカウントされます。各モジュールのリ

ソース使用量には、図 3-3に示すように、2つの数字があります。例え

ば、モジュール alttopの LUTリソースの 2827(6)では、6はモジュール自

体により使用される LUTの数、2827はモジュールとそのサブモジュール

により使用される LUTの数です。 

図 3-3 Hierarchyウィンドウでのリソース情報の表示 

 

3.6.3 ファイルの暗号化 

プロジェクトが開いているとき、ユーザーが FPGAデザインのソース

ファイルの全部または一部を暗号化したい場合は、Hierarchyウィンドウ

で暗号化するモジュールを右クリックし、右クリックメニューの「Pack 

User Design」をクリックして合成後の暗号化ファイルを生成できます。

「Pack User Design」ダイアログボックスを図 3-4に示します。 
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図 3-4 Pack User Designダイアログボックス  

 

 

Pack User Designダイアログボックスの各構成項目の意味は次のとお

りです。 

 Create In：暗号化ファイルのターゲットパス(絶対パスのみをサポー

ト)。デフォルトはプロジェクトパス¥src¥<topmodule_name>_pack

です。 

 Language：ハードウェア記述言語を選択します。Verilog(デフォルト)

および VHDLをサポートします。 

 Target Top Module：暗号化するトップ・モジュール。デフォルトは、

Hierarchyウィンドウで選択されたモジュールであり、それは変更で

きます。 

 Source Files：Hierarchyウィンドウで選択したモジュールとサブモジ

ュールのソースファイルを一覧表示します。 

 Add File：暗号化する設計ファイルを追加します。 

 Remove File：暗号化する必要のない設計ファイルを削除します。 

 Outputウィンドウ：実行情報ウィンドウ。 

 Pack：暗号化を実行します。 

 Stop：暗号化を終了します。 

暗号化が開始される時および暗号化が成功した時、関連する情報が

Outputウィンドウに出力されます(図 3-5)。暗号化中にエラーがある場
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合、エラー情報と暗号化失敗情報が Outputウィンドウに表示されます(図

3-6)。 

図 3-5 Pack User Designダイアログボックス出力情報 

 

     

図 3-6 Pack User Designダイアログボックス暗号化失敗情報 
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暗号化が完了すると、ターゲットパスの下に 2つのファイルが生成

されます。Languageとして Verilogが選択された場合、生成されるファ

イルは<topmodule_name> _gowin.vpと<topmodule_name> _sim.vで

す。Languageとして VHDLが選択された場合、生成されたファイルは

<topmodule_name> _gowin.vhdpおよび<topmodule_name> _sim.vのよ

うになります。<topmodule_name> _gowin.vpおよび

<topmodule_name>_gowin.vhdpは、暗号化されたファイルであり、他の

ユーザーに提供できます。<topmodule_name> _sim.vは、暗号化モジュ

ールの機能シミュレーションに使用できるフラット化されたプレーンテキ

ストネットリスト・ファイルです。 

注記： 

同じサブモジュールをインスタンス化する複数のモジュールがプロジェクトにある

場合、これらのモジュールのパック後に生成されたファイルにはサブモジュールの

定義が含まれます。生成されたファイルが同じプロジェクトで使用されている場

合、サブモジュールの重複定義エラーが報告されます。よって、この使用法は避け

る必要があります。 

3.6.4 検索機能 

設計ファイルが多数ある場合は、Hierarchyウィンドウの検索アイコ

ンをクリックしてモジュール名またはファイル名で検索することができま

す。検索には、ワイルドカードの使用、完全一致など、多くのオプション

があります(図 3-7)。 

図 3-7 Hierarchyウィンドウの検索機能 

 

3.7 ソースファイル編集エリア 

基本的なファイル編集と検索機能を提供します。 

新規作成または開いたファイル、合成後に生成したファイル、Place 

& Route後に生成したファイルがいずれもテキスト編集エリアに表示され

ます。このほか、「Start Page」及びプロジェクトの「Design Summary」

も同様にテキスト編集エリアに表示されます。 
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ファイルがテキスト編集エリアに表示され、外部でファイルの変更操

作を行った場合、テキスト編集エリアで「File Changed」ダイアログボッ

クスがポップアップします。「Reload」を選択してこのファイルを再ロー

ドします。 

「File」メニューの「Close」オプション、またはテキスト編集エリ

アの現在表示するファイル名の右側の をクリックすると、テキスト編

集エリア内の現在表示中のファイルが終了します。 

「File」メニューの「Close All」項目をクリックすると、テキスト編

集エリアに表示中のすべてのファイルが終了します。 

ファイルを開いた後、ショートカットキーCtrl+Fを使用するか、ツー

ルバーの Find & Replaceをクリックして Find & Replaceダイアログボッ

クスを開くことができます。ダイアログボックスの Find Allオプションを

使用すると、次の 3つの検索範囲を選択できます：Current File、Open 

Files、および Current Project(図 3-8)。Find Allをクリックすると、

Search Resultウィンドウがソフトウェアの下にポップアップし、一致し

た項目がハイライト表示され、一致した項目の総数が最初の行の最後に表

示されます(図 3-9)。 

図 3-8 Find & Replaceダイアログボックス 

 

 

図 3-9 Search Resultウィンドウ 
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3.8 インフォメーション出力エリア 

ソフトウェアの実行過程での処理インフォメーションを表示します。

タブを手動で切り替えて別のタイプの出力情報を見ることもできます。 

 Consoleページ：Tclコマンド、警告メッセージ、エラーメッセージ

があります。 

 Messageページ：Noteメッセージ、警告メッセージ、エラーメッセ

ージがあります。 

ページの情報を消去するには、Consoleウィンドウで右クリックして

「Clear」を選択します。」Message」ウィンドウには、Note、Warning、

および Errorの 3つのサブオプションがあり、図 3-10に示すように、各

サブオプションのタブには、対応する各メッセージの数が表示されます。

現在のページの情報を消去するには、Messageウィンドウで右クリック

して「Clear」を選択します。 

図 3-10インフォメーション出力エリア 

 

 

ErrorまたはWarningメッセージを選択し、右クリックして「Help」

を選択するか、ショートカットキー「F1」を押すると、Errorまたは

Warningに関する「GOWIN Help」ヘルプドキュメントが表示されます。

ErrorまたはWarningについては、ドキュメントで詳しく説明されます。

一般的な ErrorまたはWarningメッセージの一部を表 3-1に示します。ヘ

ルプドキュメントは、メニューバーの Help > View Helpを選択して表示

できます。 

表 3-1一般的なWarningまたは Errorメッセージ 

名称 コード 説明 

Warning 

WARN (PA1002): <file>:<line> | Invalid 
parameterized value <value>(<parameter>) 
specified for instance <instanceName> 

指定された場所のデバ

イスには、間違ったパ

ラメータ値が構成され

ています。 

WARN (PA1008): <file>:<line> | Object 
<name> is already defined 

ネットまたはポートの

重複定義があります。 

WARN (PA1001) : Dangling net 
<netName>(source:<instanceName>) in 
module <moduleName> has no destination  

指定されたモジュール

のネットが対象に接続

されていません。 

WARN (CT1098) : <file>:<line> | Group name 
<name> is already defined 

制約グループの重複定
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名称 コード 説明 

義があります。 

WARN (CT1101) : <file>:<line> | Location 
column <number> is out of chip 
range(<maxColumn>) 

制約位置情報の列がチ

ップの範囲外です。 

Error 

ERROR (PA2000): <file>:<line> | Syntax 
error near token <name> 

構文エラーがありま

す。例えば： 

ERROR (PA2001): <file>:<line> | Module 
<moduleName> is already defined 

モジュールの重複定義

があります。例えば： 

ERROR (PA2017): The number(<value>) of 
<instType> in the design exceeds the 
resource limit(<maxValue>) of current device 

モジュール数が制限を

超えています。 

ERROR (PA2025): No <instType> resource 
in current device 

サポートされないデバ

イスがあります。 

ERROR (PA2054): <file>:<line> | <name> is 
already declared 

デバイスの名前が重複

しています。 

  

Consoleページの下部には、Tclコマンド編集ウィンドウがありま

す。ウィンドウに Tclコマンドを入力して Enterキーを押してコマンドを

実行できます(図 3-11)。Tclコマンドの使用の詳細については、このドキ

ュメントの 8 Tclコマンドの説明を参照してください。 

図 3-11 Tclコマンド編集ウィンドウ 
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4Gowinソフトウェアの使用 

Gowinソフトウェアは、GUIモードとコマンド・ライン・モードを

サポートしています。コマンド・ライン・モードの使用については、8 Tcl

コマンドの説明を参照してください。 

Windows 10での Gowinソフトウェアを例にソフトウェアの使用方法

を紹介します。 

4.1 プロジェクトの新規作成 

1. 「File > New…」をクリックして「New」ダイアログを開きます(図

4-1)。 

図 4-1プロジェクトの新規作成 

 

注記： 

または、以下の 3つの方法を使用して「New」ダイアログボックスを開きます。 

 ショートカットキーCtrl+Nを使用します。 

 ツールバーの「New File or Project」アイコンをクリックします。 

 Start Pageウィンドウの「Quick Start>New Project」をクリックします。 
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2. デフォルトで「FPGA Design Project」が選択されています。[OK]を

クリックすると「Project Wizard」ダイアログボックスがポップアッ

プします(図 4-2)。 

図 4-2プロジェクト新規作成ウィザード                                                                                                      

 
 

3. プロジェクト名とパスを作成します(図 4-2)。 

a) 「Name」テキストボックスにプロジェクト名を入力します。 

b) 「 」をクリックしてプロジェクトパスを選択します。 

「Use as default project location」を選択すると、プロジェクトパス

がデフォルトのパスとして設定され、次に新しいプロジェクトを作成

するときに、デフォルトでこのパスに作成されます。 

注記： 

 Windowsと Linuxではファイルパスの長さが制限されています。Windowsシス

テムのパスの長さは 260文字に制限されており、Linuxシステムのパスの長さ

は 4096文字に制限されています。パスの長さが制限を超えた場合、パスの削除

またはコピーは失敗します。 

 Linuxと異なり、Windowsのパスの区切り文字は「¥」(例えば：E:¥Gowin¥ide)

です。 

4. 「Next」をクリックして、FPGAのデバイス情報を設定します。5つ

のフィルタオプション(Series、Device、Package、Speed、および

Device Version)があります。また、検索機能も利用可能です。 

 Seriesでシリーズをフィルタリングします 

 Deviceでデバイスをフィルタリングします 

 Packageでパッケージタイプをフィルタリングします 

 Speedでスピードグレードをフィルタリングします 

 Device Versionでデバイスのバージョンをフィルタリングします 

 「Part Number」でチップの型番を選択します。また、この列で

は選択したデバイスの詳しいリソース情報が表示されます。

Device Versionがないデバイスの場合、Device Version列は空列

で表示され、デバイスの Device Versionは逆順に表示されます(図
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4-3)。 

図 4-3 FPGAデバイスの情報の設定 

 

5. 「Next」をクリックし、「Summary」ウィンドウで新規作成された

FPGAプロジェクトのプロジェクト情報とデバイス情報を確認します

(図 4-4)。 

図 4-4プロジェクト情報 

 
 

6. 「Finish」をクリックしてプロジェクト作成を完了します。 

4.2 プロジェクトを開く 

ユーザーは、Gowinソフトウェアの GUIから、作成済みの Gowinソ

フトウェア・プロジェクトを開くことができます。プロジェクトを開くに

は、次の 5つの方法があります。 
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ツールバーから開く 

1. ツールバーの「 」アイコンをクリックして、「Open File」ダイアロ

グボックスを開くことができます。 

2. プロジェクトファイル(*.gprj)」を選択し、「Open」をクリックしてプ

ロジェクトを開きます。 

図 4-5ファイルを開く 

 

 

メニューバーから開く 

1. メニューで「File>Open …」を選択し、「Open File」ダイアログを開

きます(図 4-5)。 

2. プロジェクトファイル(*.gprj)」を選択し、「Open」をクリックしてプ

ロジェクトを開きます。 

Start Pageから開く 

1. 「Start Page」ページで「 」をクリックして「Open Project」ダ

イアログを開きます。 

2. プロジェクトファイル(*.gprj)」を選択し、「Open」をクリックしてプ

ロジェクトを開きます。 

Recent Projectsから開く 

メニューバーで「File>Recent Projects」を選択し、開きたいプロジェ

クトをクリックします。 

注記： 

 「Start Page>Recent Projects」リストで開きたいプロジェクトを選択すること

もできます。 

 Recent Projectsは最近開いたプロジェクトのリスト(最大 10個のプロジェクト)

です。 
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  そのプロジェクトが削除済されている場合、「Open Project」プロンプトがポッ

プアップします。 

プロジェクトファイルで開く 

プロジェクトファイル(* .gprj)をダブルクリックしてプロジェクトを

開きます。 

4.3 プロジェクトの編集 

プロジェクトを新規作成または開いた後、プロジェクト管理ウィンド

ウで FPGAプロジェクトデバイス情報や関連ファイルなどを編集できま

す(図 4-6)。 

プロジェクト管理エリアには、主に次の情報が含まれています。 

 FPGAプロジェクトのパス情報。 

 使用されるデバイスの型番。 

 ユーザーデザインファイル（Source Files）、制約ファイル、構成ファ

イルなど、現在のプロジェクトに含まれるファイル情報。その中で、

制約ファイルには、物理制約ファイル（.cst）、タイミング制約ファイ

ル（.sdc）が含まれ、構成ファイルには、GAO構成ファイル

（.gao、.rao）、消費電力解析構成ファイル（.gpa）、仮想入力出力の

構成ファイル（.gvio）などが含まれます。 

図 4-6プロジェクトファイル・ウィンドウ 

 

4.3.1 プロジェクトデバイスの編集 

現在使用されているデバイスの型番は、プロジェクト管理エリアで

変更できます。 

1. 図 4-6に示すように、「GW1N-LV4LQ144C6/I5」をダブルクリックし

て「Select Device」ダイアログボックスを開くか、メニューバーの

Project > Set Deviceを選択します(図 4-7)。 
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2. 「Select Device」ダイアログボックスで FPGAデバイス情報を設定

し、「Part Number」欄で型番を選択することで、現在のプロジェクト

で使用されているデバイスを編集します。「Part Number」欄には、デ

バイスのバージョン、パッケージ情報、スピードグレード、コア電

圧、チップに含まれる IO/LUT/FF/SSRAM/BSRAM/User 

Flash/DSP/PLLリソースの数など、選択したチップのデバイスの詳細

情報が表示されます。 

注記： 

空の Device Version(デバイスのバージョン)は、初期バージョンであることを意味し

ます。チップの date codeの末尾には、デバイスのバージョンを表す文字がありま

す。「Part Number」欄で選択されたデバイスのバージョンは、使用しているデバイ

スのバージョンと一致している必要があります。 

図 4-7チップの型番の構成  

  

4.3.2 プロジェクトファイルの編集 

プロジェクトに追加する必要があるファイルには、ユーザーRTL設計

ファイル(Source Files)、制約ファイル、構成ファイルが含まれます。プ

ロジェクトに必要なファイルを編集する方法を紹介します。 

設計ファイルと制約ファイルの新規作成 

1. ツールバーの「 」をクリックするか、メニューバーの File > 

「New...」を選択します。 

2. 新規作成したいファイルを選択します(図 4-8)。 
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図 4-8ファイル新規作成ダイアログボックス 

 

① ユーザーVerilog設計ファ

イル 

② ユーザーVHDL設計ファ

イル 

③ 物理制約ファイル ④ タイミング制約ファイル 

⑤ 合成最適化制約ファイル ⑥ User Flashの初期化ファ

イル 

⑦ Gowinアナライザオシロ

スコープの構成ファイル 

⑧ 仮想入力出力の構成ファ

イル 

⑨ 消費電力解析の構成ファ

イル 

⑩ メモリ初期化ファイル 

⑪ ファイルタイプの説明  

3. 例えば、Verilog Fileの新規作成の場合、「Verilog File」を選択し、

Verilog File新規作成ダイアログボックスを開きます。ファイル拡張形

式を選択できます(図 4-9)。「Add to current project」はデフォルトでチ

ェックされています。つまり、新しく作成された設計ファイルはデフ

ォルトで現在のプロジェクトに追加されます。 

図 4-9 Verilog Fileの新規作成  
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4. ファイル名を入力し、「OK」をクリックします。 

構成ファイルの新規作成 

1. ツールバーの「 」をクリックするか、メニューバーの File > 

「New...」を選択します(図 4-8)。 

2. 図 4-8で、新規作成したい構成ファイルの種類を選択します。例え

ば、消費電力解析構成ファイルの新規作成の場合、「GPA Config File」

を選択して New GPA Config Fileダイアログボックスを開きます。図

4-10に示すように、ファイル名を入力し、「OK」をクリックすると、

新しい GPA構成ファイルが自動的にプロジェクト管理エリアに追加さ

れます。 

3. プロジェクト管理エイラで構成ファイルをダブルクリックして、編集

用の空の構成ファイルをウィンドウの形式で開きます(図 4-11)。 

図 4-10構成ファイル新規作成ダイアログボックス 

 

図 4-11 GPA構成ファイルウィンドウ 
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プロジェクトファイルの追加 

1. 図 4-12に示すように、プロジェクト管理エリアの空白で右クリック

し、「Add Files…」を選択し、「Select Files」ダイアログボックスを開

きます。 

2. プロジェクトファイルは、同時に複数、または 1つのファイルを選択

できます。選択後、ユーザーデザインファイルの追加が完了します。

追加後、ソフトウェアはプロジェクトファイル管理エリアのファイル

を自動的に分類します。追加されたファイルが RTL設計ンファイル、

ネットリスト・ファイル、制約ファイル、GPA構成ファイル、GAO

構成ファイルでない場合、ファイル分類「Other Files」がプロジェク

ト管理エリアに追加されます。 

図 4-12 Designウィンドウの右クリックメニュー 

  
 

プロジェクトファイルの変更 

図 4-13に示すように、ファイルを開くには以下の 2つの方法があり

ます。 

1. プロジェクト管理エリアでファイルをクリックすると、そのファイル

がソースファイル編集エリアに表示されます。 

2. ファイルを右クリックし、「Open」をクリックします。 
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図 4-13プロジェクトファイル編集メニュー 

 

 

 ユーザーがメニューバーの Tools > Optionsでサードパーティのテキ

スト編集ソフトウェアを設定している場合は、「Open With…」を選択し

て、サードパーティのテキスト編集ソフトウェアで設計ファイルを開くこ

とができます。「Add External Editor」を選択した場合、ユーザーはサー

ドパーティのエディタを追加できます(図 4-14)。「Always Use External 

Editor」をチェックすると、常にサードパーティのエディタで設計ファイ

ルを開くようになります。右クリックメニューから「Open Containing 

Folder」を選択すると、ファイルが所在するフォルダが開きます。「Open 

Terminal Here」を選択すると、コマンド・ラインの実行ウィンドウが開

き、ユーザーはコマンド・ライン・モードで実行できます。 

ユーザーが外部のエディタを使用し、Gowinソフトウェア編集エリア

で開いたファイルを変更及び保存すると、Gowinソフトウェアはプロジ

ェクトファイル変更通知をポップアップします。 

ユーザーが編集後に保存していないファイルを閉じようとすると、

Gowinソフトウェアはプロジェクトファイル保存通知をポップアップし

ます。 
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図 4-14外部エディタ 

 

変更されたプロジェクトファイルを保存しないまま Synthesizeまた

は Place&Routeを実行する場合は、「Save Modified Files」プロンプトボ

ックスがポップアップします(図 4-15)。 

図 4-15 Save Modified Filesダイアログボックス 

 

 

「OK」をクリックすると、ファイルが保存され、実行したいプロセ

スが実行されます。「Cancel」をクリックすると、ファイルは保存され

ず、Synthesizeや Place&Routeも実行されません。 

プロジェクトファイルの削除 

1. プロジェクト管理エリアのファイルを選択します。 

2. 右クリックして「Remove」を選択するか、キーボードの「Delete」キ

ーを直接押すと、「Remove Files」ダイアログボックスが表示されま

す。「Remove Permanently on Disk」をチェックすると、ファイルは

現在のプロジェクトから削除され、ディスクから削除されます。それ

以外の場合 、ファイルは現在のプロジェクトからのみ削除されます。 

プロジェクトファイルの属性の編集 

プロジェクト管理エリアでファイルを右クリックし、右クリックメニ

ューから「File Properties」を選択すると、図 4-16に示すように、ファイ
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ルのファイル属性ダイアログボックスが表示されます。ダイアログボック

スには、ファイルのパス情報、変更時間、Type、Library情報が含まれま

す。Typeドロップダウンメニューでは、ファイルのタイプ情報を編集す

ることができます。OKをクリックすると、Designウィンドウで選択さ

れたタイプに自動的に移動します。Libraryは、VHDLファイルを合成す

るためのコンパイルライブラリを指定するために使用されます。デフォル

トは workです。複数のライブラリがある場合は、それらを「;」で区切る

必要があります。 

図 4-16プロジェクトファイル属性ダイアログボックス 

 
 

複数の Verilogファイルまたは複数の VHDLファイルが選択されてい

る場合、「File Properties」ダイアログボックスにパス情報と変更時間は表

示されません。Verilogファイルと VHDLファイルの両方が選択されてい

る場合、「File Properties」ダイアログボックスにパス情報、変更時間、お

よびタイプは表示されません。 

 Libraryの使用法は次のとおりです。 

 デザインのトップレベル（または上位レベル）エンティティに最下位

エンティティの componentがある場合、最下位エンティティがどの

Libraryに属しているかを気にする必要はなく、デフォルト値 workを

使用できます。 

 デザインのトップレベル（または上位レベル）エンティティが最下位

エンティティ（uut1：entity mb.sub1など）を「uut1：entityライブラ

リ名.最下位エンティティ名」の形式で呼び出す場合、最下位のエンテ

ィティがある vhdlファイルの libraryは、ライブラリ名（mbなど）で

ある必要があります。 

 パッケージ内に最下位エンティティの componentがある場合、トッ

プレベル（または上位レベル）のエンティティがパッケージを介して

最下位エンティティを呼び出すとき、最下位エンティティがどの

libraryに属するかを気にする必要なく、デフォルト値 workを使用で

きます。 

 パッケージ内に最下位エンティティの componentがある場合、最上

位（または上位）のエンティティは、「uut：パッケージが属するライ

ブラリ名.パッケージ名.最下位エンティティ名」の形式で最下位エン
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ティティ（uut1：work.pack.sub1など）を呼び出す時、最下位エンテ

ィティがどの libraryに属するかを気にする必要なく、デフォルト値

workを使用できます。 

プロジェクトファイルのイネーブル 

ユーザーはプロジェクト管理エリアの任意のファイルを右クリックし

て[Enable]と[Disable]のオプションを確認できます(図 4-13)。イネーブル

されたファイルはプロジェクトのコンパイルプロセスに参加します。 

1. 右クリックで Enable/ Disableを設定します(個別のファイルの設定と

複数ファイルの一括設定を含む)。 

2. 複数の制約ファイルまたは構成ファイルの場合、1つのファイルのみ

を Enable状態にすることができます。同じ種類の新しいファイルを作

成または追加すると、前のファイルは無効になります。 

4.3.3 プロジェクトの構成  

プロジェクト管理エリアで「Synthesize」または「Place & Route」

を右クリックして「Configuration」を選択し、プロジェクト構成ダイアロ

グボックスを開きます(図 4-17)。 

図 4-17プロジェクトの構成オプション 

 

図 4-17に示すように、構成可能なプロジェクトオプションには、

「Global」、「Synthesize」、「Place & Route」、および「BitStream」が含

まれます。構成可能な各オプションの詳細は次のとおりです。 

Global 

Globalオプションには、Generalと Constraintsが含まれています。 

General 

Generalオプションでは、出力ファイルの基本名を指定できます。デ

フォルトは現在のプロジェクトの名前です(図 4-18)。 
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図 4-18 Generalオプション 

 

 

Constraints 

Constraintsオプションの構成を図 4-19に示します。このオプション

を使用して、ユーザーデザインのグローバル・クロックの周波数を設定で

きます。ただし、クロック周波数がタイミング制約で指定されている場合

は、タイミング制約における周波数値が優先されます。デフォルトでは、

50MHz(LittleBeeファミリー)または 100MHz(Aroraファミリー)です。 

図 4-19 Frequency(MHz)オプション 

 
 

Synthesize 

General 

Synthesizeの Generalオプションを図 4-20に示します。合成ツール

として GowinSynthesisが提供されます。また、合成オプションの構成

がサポートされます。一部のオプションの上にマウスを置くとその説明

が表示されます。 
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図 4-20 GowinSynthesisのパラメータの構成 

 
 

図 4-20の各パラメータの詳細は以下のとおりです： 

 Top Module/Entity：トップ・モジュールを指定します。 

 Include Path：インクルードパスを指定します。 

 TclPre：ソフトウェアの自動バージョン管理ファイルを指定します。 

合成するたびにバージョン番号とバージョン日付が自動的に変更され

るため、デザインのバージョンは、バージョン番号により確認するこ

とができます。 

 Verilog Language：verilog言語を指定します。System Verilog 2017、

Verilog 2001(デフォルト)、および Verilog 95をサポートします。 

 VHDL Language：VHDL言語を指定します。VHDL 1993(デフォル

ト)、VHDL 2008、および VHDL 2019をサポートします。このオプシ

ョンは、現在のプロジェクトに VHDL形式の設計ファイルが含まれて

いることが検出された場合にのみ画面に表示されます。 

 Looplimit：RTLのデフォルトのコンパイラのループ制限値で、デフォ

ルト値は 2000です。 

 Show All Warnings：このオプションをチェックすると、合成プロセ

ス中にすべての警告情報が出力されます。デフォルトではチェックさ

れていません。 

 Disable Insert Pad：ネットリストに I/O Bufferを挿入するかどうかを

設定します。デフォルトではチェックされていません。 

 Ram R/W Check：RAMに読み出しまたは書き込みの競合がある場

合、このオプションをチェックすると、RAMの周りに、シミュレー

ションの不一致を防ぐためのバイパスロジックが挿入されます。デフ

ォルトではチェックされていません。 
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注記： 

オプション構成の詳細については、『GowinSynthesisユーザーガイド(SUG550)』を

参照してください。 

Place & Route 

Place & Routeオプションには、General、Voltage、Place、Route、

Dual-Purpose、および Unused Pinがあります。各オプションの説明を表

4-1に示します。 

表 4-1 Place & Route各オプションの説明 

オプション 説明 

General 
配置配線時の一般的なパラメータの構成に使用されま

す。 

Voltage VCCXを設定するために使用されます。 

Place 配置パラメータの構成に使用されます。 

Route 配線パラメータの構成に使用されます。 

Dual-Purpose Pin 
選択したデバイスのパッケージ方法に対応する I/O情報

の構成、つまり多重化ピンの構成に使用されます。 

Unused Pin  未使用 GPIOの IO属性を設定します。 

 

「Reset all to default」をクリックすると、現在の構成はすべてデフォ

ルトの値に戻ります。 

General 

Generalオプションの構成を図 4-21に示します。 

図 4-21配置配線オプションの構成 

  

 

図 4-21の各オプションの詳細は以下のとおりです： 

http://cdn.gowinsemi.com.cn/SUG550J.pdf
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 Generate SDF File：拡張子が.sdfの標準遅延フォーマットファイルを

生成します。これは、配置配線後のネットリスト・タイミングシミュ

レーションに使用されます。デフォルトは Falseです。詳しくは、こ

のドキュメントの 7 シミュレーションファイルを参照してくださ

い。 

 Generate IBIS File：拡張子が.ibsの入力/出力バッファ情報指定ファ

イルを生成します。デフォルトは Falseです。 

 Generate Post-Place File：BSRAM配置情報のみを含む、拡張子

が.pospのファイルを生成します。デフォルトは Flaseです。 

 Generate Post-PNR Verilog Simulation Model File：Verilog言語のタ

イミングシミュレーション用のタイミングシミュレーション・モデル

ファイル(拡張子は.vo)を生成します。デフォルトは Falseです。 

 Generate Post-PNR VHDL Simulation Model File：VHDL言語のタイ

ミングシミュレーション用のタイミングシミュレーション・モデルフ

ァイル(拡張子は.vho)を生成します。デフォルトは Falseです。 

 Generate Plain Text Timing Report：拡張子が.trのテキスト形式でタ

イミングレポートを生成します。デフォルトは Falseです。 

 Promote Physical Constraint Warning to Error：物理制約の警告をエラ

ーに昇格させます。デフォルトは Trueです。 

 Show All Warnings：配置配線中にすべての警告情報を出力します。

デフォルトは Falseです。 

 Report Auto-Placed IO Information：自動的に配置される I/Oの位置情

報を報告します。デフォルトは Falseです。 

Voltage 

Voltageオプションを図 4-23に示します。このオプションでは、電圧

VCCと VCCXを設定することができます。設定可能な VCCと VCCXの

値は、デバイスによって異なります。「Reset all to default」をクリックす

ると、設定された VCCと VCCXがデフォルトの値に戻ります。 

注記： 

 VCCの設定は、GW1NZ-1/GW1NZ-2デバイスの遅延データに影響します。 

 VCCXの設定は、消費電力の計算結果に影響します。 
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図 4-22 Voltageオプションの構成 

 

 

Place 

Placeオプションを図 4-23に示します。 

図 4-23配置オプションの構成 

 

 

図 4-23の各オプションの詳細は以下のとおりです： 

 Place input register to IOB：入力バッファに接続されるレジスタを

IOBに配置します。GW5A(S)(T)-138/GW5AT-75デバイスの場合、デ

フォルトは Falseで、その他の場合、デフォルトは Trueです。 

 Place output register to IOB：出力/トライステートバッファに接続さ
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れるレジスタを IOBに配置します。GW5A(S)(T)-138デバイスの場

合、デフォルトは Falseで、その他の場合、デフォルトは Trueで

す。 

 Place inout register to IOB：双方向バッファに接続されるレジスタを

IOBに配置します。GW5A(S)(T)-138デバイスの場合、デフォルトは

Falseで、その他の場合、デフォルトは Trueです。 

 Place Option：配置アルゴリズムのオプションです。

GW5A(N)(S)(R)(T)シリーズの場合、選択可能な値は 0、1、2、3、4

であり、その他のシリーズの場合、選択可能な値は 0、1、2です。デ

フォルトは 0です。 

 Replicate Resources：高ファンアウトのリソースを複製してファンア

ウトを低減し、タイミングの結果を改善します。デフォルト値は

Falseです。このオプションは、GW5A(N)(S)(R)(T)デバイスでのみサ

ポートされ、他のデバイスの場合は表示されません。 

Route 

Routeオプションを図 4-24に示します。 

図 4-24配線オプションの構成 

 
 

図 4-24の各オプションの詳細は以下のとおりです： 

 Clock Route Order: クロックプリミティブにより生成されたクロック

ライン以外のクロックラインの配線割り当て順を指定します。0と 1

の２つのオプションがあり、デフォルトは 0です。 

- 0の場合、netのファンアウト数の多い順で割り当てます。 

- 1の場合、周波数の高い順で割り当てます。 
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 Run Timing Driven：タイミングドリブン配線を実行します。デフォル

トは Trueです。 

 Route Option：配線アルゴリズムのオプション(0、１、または 2)で

す。デフォルトは 0です。 

- 0の場合、デフォルトの配線アルゴリズムを使用します。 

- 1の場合、より良い配線結果を見つけるためにコンパイル速度が

低下します。 

- 2の場合、配線速度が向上します。 

 Route Maxfan：配線のファンアウトの最大数を設定します。値は 0よ

り大きく 100以下の整数である必要があります。この値を小さい値に

設定すると、配線が失敗する場合があります。このオプションは、

LW(long wire)およびクロック関連の配線を制御しません。デバイスが

GW1NZ-1/GW1N-2/GW1NR-2/GW1N-1P5の場合、Route Maxfanの

デフォルト値は 10で、他のデバイスの場合、デフォルト値は 23で

す。 

 Correct Hold Violation：配線によりタイミングの Hold違反を自動修正

します。デフォルト値は Trueです。 

Dual-Purpose Pin 

Dual-Purpose Pinオプションは、多重化ピンを構成するために使用さ

れます。オプションの上にマウスを置くと、その説明が表示されます。構

成オプションの詳細は図 4-25のとおりです。 

図 4-25多重化ピンオプションの構成 

 
 

図 4-25の各オプションの詳細は以下のとおりです： 
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 Use JTAG as regular IO：JTAGピンを通常の IOピンとして多重化し

ます。 

 Use SSPI as regular IO：SSPIピンを通常の IOピンとして多重化し

ます。GW5A-25デバイス MBGA121Nパッケージの場合、このオプ

ションはデフォルトでチェック済みで変更不可です。 

 Use MSPI as regular IO：MSPIピンを通常の IOピンとして多重化し

ます。 

 Use READY as regular IO：READYピンを通常の IOピンとして多重

化します。 

 Use DONE as regular IO：DONEピンを通常の IOピンとして多重化

します。 

 Use RECONFIG_N as regular IO：RECONFIG_Nピンを通常の IOピ

ンとして多重化します。 

 Use I2C as regular IO：I2Cピンを通常の IOピンとして多重化しま

す。 

 Use CPU as regular IO：CPUピンを通常の IOピンとして多重化しま

す。このオプションは GW5A(N)(S)(R)(T)デバイスでのみサポートさ

れます。 

Unused Pin 

Unused Pinオプションでは、未使用の GPIOの IO属性を構成できま

す。2つのオプションがあります：As input tri-stated with pull-up 

(default) 、As open drain driving ground。図 4-26に示すとおりです。 

図 4-26 Unused Pinオプション 

 
 

 As input tri-stated with pull-up (default) ：未使用の GPIOを、弱いプ
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ルアップを持つトライステート入力として構成します。 

 As open drain driving ground：未使用の GPIOを出力として構成しま

す(OPEN DRAINはオン)。 

Incremental PnR 

Incremental PnRオプションは、インクリメンタル・コンパイル機能

を選択するために使用されます。このオプションを有効にすることによ

り、前回の配置または配置配線の結果を再利用でき、再度配置と配線の時

間が短縮され、作業効率が向上します。このオプションは図 4-27に示す

とおりです。 

図 4-27 Incremental PnRオプション 

 

 

各オプションの詳細は以下のとおりです： 

Incremental Placement Only：インクリメンタル配置のみ。デフォル

トではチェックされていません。チェックすると、以下のサブ構成オプシ

ョンが表示されます。 

 Auto：再度配置時に、プロジェクトパスにある既存のインクリメンタ

ル配置ファイル *.pが自動的に選択されます。*.pファイルがプロジ

ェクトパスに存在しない場合は、プロンプトが表示されます。 

 Specify the previous placement file：インクリメンタル配置ファイル

*.pを手動で指定します。 

Incremental Placement and Routing：インクリメンタル配置配線。デ

フォルトではチェックされていません。チェックすると、以下のサブ構成

オプションが表示され、「Incremental Placement Only」は選択できなく

なります。 
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 Auto：再度配置配線時に、プロジェクトパスにある既存のインクリメ

ンタル配置配線ファイル*.prが自動的に選択されます。*.prファイル

がプロジェクトパスに存在しない場合は、プロンプトが表示されま

す。 

 Specify the previous placement and routing file：インクリメンタル配

置配線ファイル*.prを手動で指定します。 

BitStream 

BitStreamでは、GOWINチップのダウンロードモードのビットスト

リームファイル形式やダウンロード速度などを構成します。オプションの

上にマウスを置くと、その説明が表示されます。BitStreamの構成オプシ

ョンには、General、sysControl、および Feature sysControlがありま

す。各オプションの意味を表 4-2に示します。 

表 4-2 BitStreamの構成オプションの意味 

オプション 説明 

General 
BitStreamの一般的なパラメータの構成に使用されま

す。 

sysControl 
BitStreamのシステム制御パラメータの構成に使用され

ます。 

Featrue sysControl 
BitStreamの機能システム制御パラメータの構成に使用

されます。 

 

General 

Generalオプションの構成を図 4-28に示します。 

図 4-28 Bitstreamの Generalオプションの構成   

 

 

図 4-28各パラメータの詳細は以下のとおりです： 
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 Enable CRC Check：巡回冗長検査を有効にします。デフォルトでは

チェックされています。 

 Enable Compress：ビットストリームファイルの圧縮を有効にしま

す。デフォルトではチェックされていません。 

 Enable Encryption：ビットストリームファイルを暗号化します(Arora

ファミリーのみこのオプションをサポート)。デフォルトではチェッ

クされていません。 

 Key(Hex)：ここでは、暗号化キーをカスタマイズできます(Aroraファ

ミリーのみをサポート)。「Enable Encryption」がチェックされている

場合にのみ編集できます。デフォルトではキーはすべて 0です。この

オプションをチェックして配置配線を実行すると、キー・ファイ

ル.ekeyが生成されます。 

 Enable Security Bit：セキュリティ・ビット制御を有効にします。ビ

ットストリームファイルにセキュリティ・ビットを追加すると、ビッ

トストリームをリードバックすることはできません。デフォルトでは

チェックされています。 

 Secure Mode：セキュアモードを有効にすると、JTAGピンは GPIO

となり、デバイスは 1回しかプログラムできなくなります。この機能

は GW1NSER-4Cデバイスのみでサポートされ、デフォルトではチェ

ックされていません。 

 Power On Reset Monitor：パワーオンリセット監視。デフォルトでチ

ェックされています。このオプションをチェックすると、電源レール

の電圧降下が継続的に監視されます。電源レール電圧が PORスレッ

ショルドを下回ると、RAMのすべてのビットがクリアされ、使用さ

れている I/Oが内部の弱いプルアップ抵抗によってトライステートに

設定されます。次にコンフィグレーションと初期化を完了します。 

 Turn Off Bandgap：Bandgap機能をオフにします。デフォルトではチ

ェックされていません。Bandgapはチップ内の一部のモジュールに一

定の電圧と電流を供給します。Bandgapをオフにすると、デバイスの

消費電力を削減できます。このオプションは、GW1N-1デバイスでの

みサポートされ、他のデバイスの場合は表示されません。 

 Print BSRAM Initial Value：BSRAMの初期値をビットストリームファ

イルに書き込みます。デフォルトではチェックされています。

GW1N(X)シリーズおよび GW2A(X)シリーズの場合、このオプション

をチェックすると、すべての位置の BSRAMの初期値がビットストリ

ームファイルに書き込まれます(占有されていない BSRAM位置の初

期値は 0として取り扱われます)。GW5A(N)(S)(R)(T)デバイスの場

合、このオプションをチェックすると、占有された BSRAMの所在列

にあるすべての BSRAMの初期値がビットストリームファイルに書き

込まれます(この列の占有されていない BSRAM位置の初期値は 0と

して取り扱われます)。 
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 Bitstream Format：ビットストリームファイルの形式を指定します。

Textと Binary(デフォルト)の 2つの形式があります。Textを選択する

場合、プレーンテキスト形式の*.fsファイルが生成され、Binaryを選

択する場合、*.fs 、*.bin、および*.binx形式のビットストリームファ

イルが生成されます。*.binおよび*.binxはバイナリ形式のビットスト

リームファイルで、*.binxファイルにはヘッダーコメント情報が含ま

れ、*.binにはヘッダーコメント情報が含まれていません。 

sysControl 

sysControlオプションの構成を図 4-29に示します。 

図 4-29 sysControlオプションの構成 

 

 

図 4-29各パラメータの詳細は以下のとおりです： 

 Program Done Bypass：Done Final信号が有効になった場合、外部の

Done信号を Lowのままにすることにより、ビットストリームがロー

ドされた後に新しいビットストリームデータを転送できるようにしま

す。 

 Wake Up Mode：チップのウェイクアップモード。値は 0(デフォル

ト)と 1です。 

- Wake Up Modeが 0の場合、DONEピンを Highまたは Lowにプ

ルしてもWake Upには影響しません。 

- Wake Up Modeが 1の場合： 

a) Wake Up Modeが 1の場合、DONEピンが Highにプルアッ

プされている場合、正常にダウンロードでき、かつチップは

正常に動作できます。 
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b) DONEピンが Lowにプルダウンされている場合、ダウンロー

ドできますが、デバイスをウェイクアップするには、ダウン

ロードされた後、DONEピンを Highにプルアップして TCK

をパルス信号に接続する必要があります。 

 User Code：User Codeはカスタマイズできます。カスタマイズされ

た値は生成されたビットストリームファイルに反映され、User Code

はビットストリームファイルが Programmerを介してダウンロードさ

れるときに検証されます。デフォルトは 00000000です。 

 Loading Rate：AUTO BOOTコンフィギュレーション・モードおよび

MSPIコンフィギュレーション・モードでの、Flashから SRAMへの

ビットストリームファイルの読み込み速度です。GW1N-4/GW1NRF-

4B/GW1NR-4の場合、デフォルトで 2.100MHzです。C7/I6スピード

グレードの GW1NS-4/GW1NSR-4/GW1NSER-4Cの的場合、デフォ

ルトで 2.6MHzです。GW5A(S)(T)-138/GW5A(R)-25の的場合、デフ

ォルトで 35.000MHzです。その他のデバイスの場合、デフォルトで

2.500MHzです。AUTO BOOTコンフィギュレーション・モードおよ

び MSPIコンフィギュレーション・モードについては、『Gowin FPGA

製品プログラミング・コンフィギュレーション ユーザーガイド

(UG290)』、『Arora V 138K FPGA製品プログラミング・コンフィギュ

レーション ユーザーガイド(UG704)』、および『Arora V 25K FPGA

製品プログラミング・コンフィギュレーション ユーザーガイド

(UG714)』を参照してください。Loading Rateの値と計算方法はデバ

イスによって異なります。 

- 次のデバイスとパッケージの組み合わせは 2.500MHzの Loading 

Rateのみをサポートします。 

a) GW1N-2：
LQFP100X/LQFP144X/MBGA132X/WLCSP42H/MBGA49 

b) Bバージョンの GW1N-2：
LQFP100X/LQFP144X/MBGA132X/MBGA121X 

c) Cバージョンの GW1N-2：
LQFP100X/LQFP144X/MBGA132X/MBGA121X 
/MBGA49/QFN32X 

d) GW1NR-2：MBGA49P/MBGA49PG/MBGA49G 

e) Bバージョンの GW1NR-2：
MBGA49P/MBGA49PG/MBGA49G 

f) Cバージョンの GW1NR-2：
MBGA49P/MBGA49PG/MBGA49G 

g) GW1N-1P5：LQFP100X 

h) Bバージョンの GW1N-1P5：LQFP100X/QFN48X 

i) Cバージョンの GW1N-1P5：LQFP100X/QFN48X 

http://cdn.gowinsemi.com.cn/UG290J.pdf
http://cdn.gowinsemi.com.cn/UG704J.pdf
http://cdn.gowinsemi.com.cn/UG704J.pdf
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- 次のデバイスの Loading Rateの値と計算方法は表 4-3に示すとお

りです。 

a) GW1NZ-1 

b) GW1N-2/GW1N-1P5/GW1NR-2(上記の 2.500MHzのみをサポ

ートするパッケージを除く) 

c) GW1NSER-4C/GW1NS-4/GW1NSR-4/GW1NS-4C/ 

GW1NSR-4C(スピードグレードが C7/I6のデバイスを除く) 

d) GW1N-9/GW1NR-9  

e) GW2A-18/GW2AR-18/Cバージョンの GW2ANR-18 

f) GW2A-55/Cバージョンの GW2AN-55 

表 4-3 Loading Rateの値と計算方法(一) 

Loading Rate (MHz) 分数表記 

2.500 (default) 250 / 100 

5.435 250 / 46 

5.682 250 / 44 

5.952 250 / 42 

6.250 250 / 40 

6.579 250 / 38 

6.944 250 / 36 

7.353 250 / 34 

7.812 250 / 32 

8.333 250 / 30 

8.929 250 / 28 

9.615 250 / 26 

10.417 250 / 24 

11.364 250 / 22 

12.500 250 / 20 

13.889 250 / 18 

15.625 250 / 16 

17.857 250 / 14 

20.833 250 / 12 

25.000 250 / 10 

31.250 250 / 8 

41.667 250 / 6 

62.500 250 / 4 

   

- 次のデバイスの Loading Rateの値と計算方法は表 4-4に示すとお

りです。 
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GW1N-1/GW1N-1S/GW1NR-1 

表 4-4 Loading Rateの値と計算方法(二) 

Loading Rate(MHz) 分数表記 

2.500 (default) 240 / 96 

2.553 240 / 94 

2.609 240 / 92 

2.667 240 / 90 

2.727 240 / 88 

2.791 240 / 86 

2.857 240 / 84 

2.927 240 / 82 

3.000 240 / 80 

3.077 240 / 78 

3.158 240 / 76 

3.243 240 / 74 

3.333 240 / 72 

3.429 240 / 70 

3.529 240 / 68 

3.636 240 / 66 

3.750 240 / 64 

3.871 240 / 62 

4.000 240 / 60 

4.138 240 / 58 

4.286 240 / 56 

4.444 240 / 54 

4.615 240 / 52 

4.800 240 / 50 

5.000 240 / 48 

5.217 240 / 46 

5.455 240 / 44 

5.714 240 / 42 

6.000 240 / 40 

6.316 240 / 38 

6.667 240 / 36 

7.059 240 / 34 

7.500 240 / 32 

8.000 240 / 30 

8.571 240 / 28 

9.231 240 / 26 
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Loading Rate(MHz) 分数表記 

10.000 240 / 24 

10.909 240 / 22 

12.000 240 / 20 

13.333 240 / 18 

15.000 240 / 16 

17.143 240 / 14 

20.000 240 / 12 

24.000 240 / 10 

30.000 240 / 8 

40.000 240 / 6 

60.000 240 / 4 

 

- 次のデバイスの Loading Rateの値と計算方法は表 4-5に示すとお

りです。 

a) GW2AN-9X 

b) GW2AN-18X 

表 4-5 Loading Rateの値と計算方法(三) 

Loading Rate(MHz) 分数表記 

2.500 (default) 200 / 80 

1.562 200 / 128 

1.587 200 / 126 

1.613 200 / 124 

1.639 200 / 122 

1.667 200 / 120 

1.695 200 / 118 

1.724 200 / 116 

1.754 200 / 114 

1.786 200 / 112 

1.818 200 / 110 

1.852 200 / 108 

1.887 200 / 106 

1.923 200 / 104 

1.961 200 / 102 

2.000 200 / 100 

2.041 200 / 98 

2.083 200 / 96 

2.128 200 / 94 

2.174 200 / 92 
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Loading Rate(MHz) 分数表記 

2.222 200 / 90 

2.273 200 / 88 

2.326 200 / 86 

2.381 200 / 84 

2.439 200 / 82 

2.564 200 / 78 

2.632 200 / 76 

2.703 200 / 74 

2.778 200 / 72 

2.857 200 / 70 

2.941 200 / 68 

3.030 200 / 66 

3.125 200 / 64 

3.226 200 / 62 

3.333 200 / 60 

3.448 200 / 58 

3.571 200 / 56 

3.704 200 / 54 

3.846 200 / 52 

4.000 200 / 50 

4.167 200 / 48 

4.348 200 / 46 

4.545 200 / 44 

4.762 200 / 42 

5.000 200 / 40 

5.263 200 / 38 

5.556 200 / 36 

5.882 200 / 34 

6.250 200 / 32 

6.667 200 / 30 

7.143 200 / 28 

7.692 200 / 26 

8.333 200 / 24 

9.091 200 / 22 

10.000 200 / 20 

11.111 200 / 18 

12.500 200 / 16 

14.286 200 / 14 
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Loading Rate(MHz) 分数表記 

16.667 200 / 12 

20.000 200 / 10 

25.000 200 / 8 

33.333 200 / 6 

50.000 200 / 4 

100.000 200 / 2 

 

- 次のデバイスの Loading Rateの値と計算方法は表 4-6に示すとお

りです。 

GW1N-4/GW1NRF-4B/GW1NR-4 

表 4-6 Loading Rateの値と計算方法(四) 

Loading Rate (MHz) 分数表記 

2.100 (default) 210 / 100 

4.565  210 / 46 

4.773  210 / 44 

5.000  210 / 42 

5.250  210 / 40 

5.526  210 / 38 

5.833  210 / 36 

6.176  210 / 34 

6.563  210 / 32 

7.000  210 / 30 

7.500  210 / 28 

8.077  210 / 26 

8.750  210 / 24 

9.545  210 / 22 

10.500  210 / 20 

11.667  210 / 18 

13.125  210 / 16 

15.000  210 / 14 

17.500  210 / 12 

21.000  210 / 10 

26.250  210 / 8 

35.000  210 / 6 

52.500  210 / 4 

 

- 次のデバイスの Loading Rateの値と計算方法は表 4-7に示すとお
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りです。 

GW1NSER-4C/GW1NS-4/GW1NSR-4/GW1NS-4C/GW1NSR-

4C(スピードグレード C7/I6) 

表 4-7 Loading Rateの値と計算方法(五) 

Loading Rate (MHz) 分数表記 

2.600  260 / 100 

5.652  260 / 46 

5.909  260 / 44 

6.190  260 / 42 

6.500  260 / 40 

6.842  260 / 38 

7.222  260 / 36 

7.647  260 / 34 

8.125  260 / 32 

8.667  260 / 30 

9.286  260 / 28 

10.000  260 / 26 

10.833  260 / 24 

11.818  260 / 22 

13.000  260 / 20 

14.444  260 / 18 

16.250  260 / 16 

18.571  250 / 14 

21.667  260 / 12 

26.000  260 / 10 

32.500  260 / 8 

43.333  260 / 6 

65.000  260 / 4 

 

- 次のデバイスの Loading Rateの値と計算方法は表 4-8に示すとお

りです。 

GW5A(S)(T)-138/GW5A(R)-25/GW5AT-75 

表 4-8 Loading Rateの値と計算方法(六) 

Loading Rate (MHz) 分数表記 

35.000(default) 210 / 6 

52.500  210 / 4 

70.000 210 / 3 

105.000  210 / 2 
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- 次のデバイスの Loading Rateの値と計算方法は表 4-9に示すとお

りです。 

GW5AT-60/GW5A(N)(R)T-15 

表 4-9 Loading Rateの値と計算方法(七) 

Loading Rate (MHz) 分数表記 

2.500 (default) 210 / 84 

1.667 210 / 126 

1.694 210 / 124 

1.721 210 / 122 

1.750 210 / 120 

1.780 210 / 118 

1.810 210 / 116 

1.842 210 / 114 

1.875 210 / 112 

1.909 210 / 110 

1.944 210 / 108 

1.981 210 / 106 

2.019 210 / 104 

2.059 210 / 102 

2.100 210 / 100 

2.143 210 / 98 

2.188 210 / 96 

2.234 210 / 94 

2.283 210 / 92 

2.333 210 / 90 

2.386 210 / 88 

2.442 210 / 86 

2.561 210 / 82 

2.625 210 / 80 

2.692 210 / 78 

2.763 210 / 76 

2.838 210 / 74 

2.917 210 / 72 

3.000 210 / 70 

3.088 210 / 68 

3.182 210 / 66 

3.281 210 / 64 

3.387 210 / 62 
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Loading Rate (MHz) 分数表記 

3.500 210 / 60 

3.621 210 / 58 

3.750 210 / 56 

3.889 210 / 54 

4.038 210 / 52 

4.200 210 / 50 

4.375 210 / 48 

4.565  210 / 46 

4.773  210 / 44 

5.000  210 / 42 

5.250  210 / 40 

5.526  210 / 38 

5.833  210 / 36 

6.176  210 / 34 

6.563  210 / 32 

7.000  210 / 30 

7.500  210 / 28 

8.077  210 / 26 

8.750  210 / 24 

9.545  210 / 22 

10.500  210 / 20 

11.667  210 / 18 

13.125  210 / 16 

15.000  210 / 14 

17.500  210 / 12 

21.000  210 / 10 

26.250  210 / 8 

35.000  210 / 6 

52.500  210 / 4 

70.000 210 / 3 

105.000  210 / 2 

 

 Background Programming：FPGAの動作を中断しないまま FPGAを

再プログラミングするバックグラウンド・アップグレード機能です。

現在のデバイスの Background Programmingの値が OFFのみの場

合、構成画面にはこの構成オプションは表示されません。 
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図 4-30 Background Programming：I2C 

 

 

図 4-31 Background Programming：I2C/JTAG/SSPI/QSSPI 

 

 

バックグラウンド・アップグレードをサポートするデバイスとその値

は次に示すとおりです。 

表 4-10 Background Programmingの値 

デバイスタイプ Background Programmingの値 

 GW1N-1P5/GW1N-2/GW1NR-2 

 Bバージョン：GW1N-4/GW1NR-

4、GW1NRF-4 

 Dバージョン：GW1NR-4 

 GW1NS-4/GW1NSR-4 

 GW1N-9/GW1NR-9 

 GW1NZ-1 

OFF、JTAG 

デフォルトではOFF 

B バ ー ジ ョ ン ： GW1N-1P5/GW1N-

2/GW1NR-2 

OFF、JTAG、I2C 

デフォルトではOFF 

C バ ー ジ ョ ン ： GW1N-2/GW1NR-

2/GW1N-1P5 

OFF、GoConfig、GoConfig Mode1、

JTAG、I2C 

デフォルトではOFF 

GW2AN-18X/GW2AN-9X 

OFF 、 GoConfig 、 UserLogic 、
I2C/JTAG/SSPI/QSSPI 

デフォルトではOFF 

GW5A(N)(S)(R)(T) 
OFF、UserLogic、JTAG/SSPI/QSSPI 

デフォルトではOFF 

 

Background Programmingの各値の機能および注意事項は、次のとお

りです。 

- OFF：バックグラウンドプログラミング機能をオフにします。デ

バイスが GW2AN-18Xまたは GW2AN-9Xの場合、「Dual-

Purpose Pin」ダイアログボックスの「Use MSPI as regular IO」

がチェックされておらず、設定不可になります。 

- JTAG：JTAGモードでバックグラウンド・アップグレードを実行

します。 

- I2C：I2Cモードでバックグラウンド・アップグレードを実行しま
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す。Bバージョンの GW1N-1P5/GW1N-2/GW1NR-2デバイスの

場合、オプション「I2C Slave Address(Hex)」が構成ダイアログ

ボックスに表示され、ユーザーが I2Cデバイスのアドレスを設定

できます。その範囲は 00〜7Fです(図 4-30)。I2Cを選択した後、

「Dual-Purpose Pin」ダイアログボックスの「Use JTAG as 

regular IO」がチェックされておらず、設定不可になります。Cバ

ージョンの GW1N-2/GW1N-1P5/GW1NR-2デバイスの場合、I2C

モードでバックグラウンド・アップグレードを実行すると、オプ

ション「I2C Slave Address(Hex)が構成ダイアログボックスに表

示されず、「Dual-Purpose Pin」ダイアログボックスの「Use 

RECONFIG as regular IO」はチェックされておらず、設定不可に

なります。 

- GoConfig：goConfig IPでバックグラウンド・アップグレードを

実行します。 

- UserLogic：内部論理でバックグラウンド・アップグレードを実行

します。 

- I2C/JTAG/SSPI/QSSPI：I2C/JTAG/SSPI/QSSPIモードでバック

グラウンド・アップグレードを実行します。 

- JTAG/SSPI/QSSPI：JTAG/SSPI/QSSPIモードでバックグラウン

ド・アップグレードを実行します。 

- GW2AN-18X/GW2AN-9Xの場合、GoConfigまたは UserLogicま

たは I2C/JTAG/SSPI/QSSPIを選択すると、構成オプション

「HOTBOOT」がダイアログボックスに表示されます(図 4-31)。

デフォルトではチェックされていません。 

- GW5A(S)(T)-138/GW5A(R)-25の場合、UserLogicまたは

JTAG/SSPI/QSSPIを選択すると、構成オプション

「HOTBOOT」がダイアログボックスに表示されます(図 4-31)。

デフォルトではチェックされていません。 

- Bバージョンの GW1N-1P5/GW1N-2/GW1NR-2の場合、構成オ

プションの切り替え前後に I2Cが含まれていると、Synthesizeと

Place＆Routeのステータスが古くなります。Cバージョンの

GW1N-1P5/GW1N-2/GW1NR-2の場合、構成オプションの切り替

え前後に I2Cが含まれていると、Place＆Routeのステータスのみ

が古くなります。 

- GW2AN-18X/GW2AN-9Xの場合、GoConfig, UserLogicと、

I2C/JTAG/SSPI/QSSPI, OFFを切り替えると、Synthesizeと

Place & Routeのステータスが古くなり、それ以外は、Place & 

Routeのステータスのみが古くなります。 

 Enable External Master Config Clock：外部マスター・コンフィギュ

レーション・クロックを有効にし(GW5A(N)(S)(R)(T)のみこのオプシ

ョンをサポート)。デフォルトではチェックされていません。このオ
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プションをチェックすると、ダイアログボックスに「Frequency 

Divider」という構成オプションが表示されます(図 4-32)。

GW5A(S)(T)-138/GW5AT-75の場合、選択可能な値は 1、2、4、8

で、デフォルトは 1です。GW5A(S) (R)-25/GW5AT-

60/GW5A(N)(R)T-15の場合、選択可能な値は 1、2～1022の偶数で、

デフォルトは 1です。 

図 4-32 Frequency Dividerオプション 

 

 

 Enable SEU Handler：シングル・イベント・アップセット・ハンドラ

（Single-Event Upsets Handler、SEU Handler）を有効にします。こ

の機能は GW5A(N)(S)(R)(T)デバイスのみでサポートされ、デフォル

トではチェックされていません。このオプションをチェックすると、

ダイアログボックスに設定サブオプション(「Enable SEU Handler 

CheckSum」、「Enable Error Detection only」、「Enable Error Detection 

and Correction」、「Stop SEU Handler when detected uncorrectable 

ECC error or CRC checksum mismatch error」、「Mode」、「Enable 

Error Injection」)が表示されます。このうち、「Enable Error Detection 

only」と「Enable Error Detection and Correction」は同時にチェック

できません。図 4-33に示す通りです。 

図 4-33 Enable SEU Handlerオプション 

 

 

図 4-34 Enable Error Injectionオプション 

 

 

- Enable SEU Handler CheckSum：シングル・イベント・アップセ

ット・ハンドリング、検出、計算、比較を有効にします。デフォ

ルトではチェックされていません。 

- Enable Error Detection only: エラー検出のみを有効にします。デ

フォルトではチェックされていません。 
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- Enable Error Detection and Correction：エラーの検出と訂正を有

効にします。デフォルトではチェックされていません。 

- Stop SEU Handler when detected uncorrectable ECC error or 

CRC checksum mismatch error：訂正不可能な ECCエラーまたは

CRCチェックサム・ミスマッチ・エラーが検出された場合、SEU 

Handlerを停止します。デフォルトではチェックされていませ

ん。 

- Mode：SEU Handlerを開始または停止するモードを選択しま

す。選択可能な値は Autoと UserLogicで、デフォルトは Autoで

す。 

- Enable Error Injection：エラー挿入を有効にします。このオプシ

ョンは UserLogicが Modeとして選択されている場合に表示され

ます。デフォルトではチェックされていません。 

 CSR File：csrファイルを指定します。 

Feature sysControl 

非 GW5A(N)(S)(R)(T)デバイスの場合、Feature sysControlオプション

の構成は図 4-35に示すとおりです。 

図 4-35 GW5A(N)(S)(R)(T)以外のデバイスの Feature sysControlオプション 

 

 

デフォルトで Multi Bootがチェックされており、サブ構成オプション

の SPI Flash Addressも表示されます。 

 SPI Flash Address：SPI Flashアドレスを指定します。SPI Flashア

ドレスは、次の multibootの際にビットストリームファイルが読み込

まれる開始アドレスです。GW2AN-18Xと GW2AN-9Xの場合、デフ
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ォルトで 000000であり、その他のデバイス(GW5A(N)(S)(R)(T)を除

く)の場合、デフォルトで 00000000です。詳細については、『Gowin 

Programmerユーザーガイド(SUG502)』を参照してください。 

GW5A(N)(S)(R)(T)デバイスの場合、Feature sysControlオプションの

構成は図 4-36に示すとおりです。 

図 4-36 GW5A(N)(S)(R)(T)デバイスの Feature sysControlオプション 

 

Multi Bootはデフォルトではチェックされていません。チェックする

と、以下のサブ構成オプションが表示されます。 

表 4-11サブ構成オプション 

名称 説明 

Address Width SPI Flashアドレスの幅(24(デフォルト値)、32)を構成し

ます。 

SPI Flash Address SPI Flashアドレスを指定します。SPI Flashアドレス

は、次のmultibootの際にビットストリームファイルが読

み込まれる開始アドレスで、デフォルトは000000で

す。詳細については、『Gowin Programmerユーザーガ

イド(SUG502)』を参照してください。 

Mode SPI Flashのアクセスモードを構成します。アクセスモ

ードには、Normal、Fast、Dual、およびQuadがあり、

デフォルトはSingleです。 

 

MSPI JUMPはデフォルトではチェックされていません。チェックす

ると、以下のサブ構成オプションが表示されます。 

表 4-12サブ構成オプション 

名称 説明 

Enable Merge Mode デフォルトではチェックされていません。チェックする

と、MSPI JUMPビットストリームファイルは汎用ビッ

トストリームファイルにマージされます。 

http://cdn.gowinsemi.com.cn/SUG502J.pdf
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名称 説明 

Address Width SPI Flashアドレスの幅(24(デフォルト値)、32)を構成し

ます。 

SPI Flash Address SPI Flashアドレスを指定します。デフォルトは000000

です。 

Mode SPI Flashのアクセスモードを構成します。アクセスモ

ードには、Normal、Fast、Dual、およびQuadがあり、

デフォルトはSingleです。 

4.4 プロジェクトのプロセス管理  

プロセス管理エリアで、Gowinソフトウェアのプロセスがリストさ

れます(図 4-37)。このウィンドウでは、次の操作が可能です。 

 Design概要の確認。 

 物理制約エディタの起動。 

 タイミング制約エディタの起動。 

 合成の実行。 

 合成設計レポートの確認。 

 配置配線の実行。 

 Place&Route後に生成されたレポートの確認。 

 Programmerの起動。 

図 4-37 Processウィンドウ 

 

4.4.1 Design Summary 

新しいプロジェクトを作成するとき、ソフトウェアにより Design 
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Summaryというレポートが提供されます。レポートには、プロジェクト

ファイルのパス、合成ツール情報、およびデバイス情報が含まれます。

Design Summaryを開くには、次の 3つの方法があります。 

 GOWIN FPGA Designerメニューで「Window> Design Summary」を

選択します。 

 Processウィンドウで「Design Summary」をダブルクリックしま

す。 

 Processウィンドウで「Design Summary」を右クリックして

「Open」を選択します。 

図 4-38 Design Summary 

  

注記： 

Device Versionがないデバイスの場合、表に Device Versionの行は表示されませ

ん。 

4.4.2 User Constraints 

User Constraintsによって、制約ファイルを素早く開き、作成するこ

とができます。User Constraintsには、物理制約とタイミング制約があり

ます。 

制約エディタの詳細については『Gowinタイミング制約ユーザーガイ

ド(SUG940)』、『Gowin物理制約ユーザーガイド(SUG935)』、およびを

『Arora Ⅴ物理制約ユーザーガイド(SUG1018)』参照してください。 

4.4.3 Synthesize 

GowinSynthesisは Gowinによって開発された合成ツールです。

GOWINSEMIライブラリファイルとその実装をサポートしています。現

在は Verilog言語(System Verilog 2017、Verilog 2001、および Verilog 

95)、VHDL言語(VHDL1993、VHDL 2008)をサポートしています。 

図 4-20に示すように、Synthesizeを右クリックし「Configuration」

を選択し、合成ツールを選択します。 

Synthesizeエリアでは、合成の実行、合成パラメータの設定、ネッ

トリスト・ファイル(Netlist File)の管理、合成レポート(Synthesis Report)

の管理といった機能を提供します。合成レポートの詳細については、6.1

合成レポートを参照してください。 

http://cdn.gowinsemi.com.cn/SUG940J.pdf
http://cdn.gowinsemi.com.cn/SUG935J.pdf
http://cdn.gowinsemi.com.cn/SUG1018J.pdf
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合成するには、以下の手順を参照してください。 

1. Synthesisオプションを構成します。Synthesisオプションの構成につ

いては、4.3.3プロジェクトの構成を参照してください。 

2. Synthesizeを実行。 

3. プロセス管理エリアで「Synthesize」をダブルクリックするか、

「Synthesize」を右クリックして Runをクリックし、合成ツールを起

動してソースファイルを合成します。合成に成功すれば、Synthesize

の前にアイコン が表示されます。失敗した場合はアイコン が表

示されます。 

4. 正常に合成した後、「Netlist File」または「Synthesis Report」をダブ

ルクリックするか、これらを右クリックして Openオプションを選択

すると、ネットリスト・ファイルや合成レポートを確認できます。ま

た、生成されたネットリスト・ファイルや合成レポートの名前とプロ

ジェクト名は同じです。生成される合成後ネットリスト・ファイルは

*.vgで、合成レポートは*_syn.rpt.htmlです。 

合成前(Synthesizeアイコンが )に、「Netlist File」または

「Synthesis Report」をダブルクリックするか、これらを右クリックして

Openオプションを選択すると、まず合成が行われます。合成完了後、ネ

ットリスト・ファイルまたは合成レポートが開きます。 

「Synthesize」の右クリックによる可能な操作は次のとおりです(図

4-39)。 

 Run：Synthesizeの前のアイコンが (初期状態)、 (失敗した状

態)、または (古い状態)の場合のみ、このオプションを選択すると

合成ツールが起動してソースファイルを合成します。 

 Rerun：Synthesizeの状態に関わらず、このオプションを選択すると

合成ツールを起動し、ソースファイルを合成します。 

 Rerun All：Synthesizeと Place & Routeの状態に関わらず、このオプ

ションを選択すると、ソースファイルが再合成されて配置配線されま

す。 

 Clean&Rerun All：プロジェクト・フォルダ implの下の gwsynthesis

フォルダと pnrフォルダをクリアし、Synthesizeと Place＆Routeを

再実行します。 

 Stop：Synthesizeプロセスを停止します。 

 Clean：合成後フォルダ(gwsynthesis)をクリアします。 

 Configuration：Synthesizeのパラメータを設定します。 
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図 4-39 Synthesizeの右クリックメニュー 

 

4.4.4 Place & Route 

Place & Routeは、配置配線の実行、配置配線パラメータの設定、配

置配線後に生成されたファイル管理を実装します。 

注記： 

Place & Routeは合成プロセスに依存します。この手順を実行する時、その依存項目

(Synthesize)が実行されていない場合、まず Synthesize(Synplify Pro)が実行され、そ

の後この手順が実行されます。 

以下の手順で Place & Routeを実行します。 

1. Place & Routeオプションを構成します。Place & Routeオプションの

構成については、4.3.3プロジェクトの構成を参照してください。 

2. Place & Routeを実行します。「Place & Route」をダブルクリックする

か、「Place & Route」を右クリックして Runをクリックすると、配置

配線が実行され、ビットストリームファイルおよび関連するレポート

ファイルが生成されます。実行に成功すれば、Place & Routeの前に

アイコン が表示されます。失敗した場合はアイコン が表示されま

す。 

3. 正常に配置配線した後、Place & Routeの下でファイルをダブルクリ

ックするか、右クリックして「Open」を選択すると、テキスト編集エ

リアでレポートファイルを確認できます。 

4. 生成される 4つのレポートファイル、つまり配置配線レポート(Place 

& Route Report)、タイミング解析レポート(Timing Analysis Report)、

ポート属性レポート(Ports & Pins Report) 、および電力解析レポート

(Power Analysis Report)を確認できます。詳しくは、6.2配置配線レポ

ート、6.3ポート属性レポート、6.4タイミングレポート、および 6.5

消費電力解析レポートを参照してください。 

注記： 
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 現在すでにレポートファイルを開いており、さらに Place & Routeを実行して

レポートファイルを生成し直すと、ファイルを更新するかというメッセージが

表示されます。 

 Place & Routeの実行前(Place & Routeの前のアイコンが )、レポートファイ

ルをダブルクリックするか、このレポートファイルを右クリックして「Open」

を選択すると、まず Place & Routeが実行され、実行後にレポートファイルが

開きます。 

Place & Routeの右クリックによる可能な操作は次のとおりです。 

 Run：Place & Routeの前のアイコンが (初期状態)、 (失敗した

状態)、または (古い状態)の場合にのみ、このオプションを選択す

ると Place & Routeが実行されます。 

 Rerun：Place & Routeの状態に関わらず、このオプションを選択す

ると Place & Routeが再実行されます。 

 Rerun All：Synthesizeと Place & Routeの状態に関わらず、このオプ

ションを選択すると、ソースファイルが再合成されて配置配線されま

す。 

 Clean & Rerun All：プロジェクト・フォルダ implの下の gwsynthesis

フォルダと pnrフォルダをクリアし、Synthesizeと Place＆Routeを

再実行します。 

 Stop：Place & Routeプロセスを停止します。 

 Clean：Place & Routeによって生成されたフォルダ(pnr)をクリアし

ます。フォルダの削除に失敗した場合、警告情報が報告されます。 

 Configuration：Place & Routeのパラメータを設定します。 

4.4.5 Programer 

Gowinソフトウェアの配置配線が成功すると、ビットストリームフ

ァイルが生成されます。ビットストリームファイルをチップにダウンロー

ドするには、GOWINセミコンダクターの Programmerを使用する必要が

あります。 

注記： 

Programerは、Synthesizeと Place & Routeステップに依存しています。このステ

ップの実行時にその依存ステップ（Synthesizeと Place & Route）がまだ実行され

ていない場合、警告が表示されます。 

「Programer」をダブルクリックするか、この項目を右クリックして

「Run」オプションを選択すると、Programmerが開きます(図 4-40)。 

注記： 

Linuxインストールパッケージの Programmerは、Red Hat 6以降のみをサポート

し、Linuxカーネルバージョンは 2.18以降である必要があります。 
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図 4-40 Programmerの GUI 

  
  

Programmerの使用法については、『Gowin Programmerユーザーガ

イド(SUG502)』を参照してください。 

4.5 プロジェクトのアーカイブと復元 

Gowinソフトウェアは、現在のプロジェクトのアーカイブとアーカ

イブされたプロジェクトの復元をサポートしています。メニューバーの

「Archive Project」および「Restore Archived Project」をクリックして、

プロジェクトをアーカイブまたは復元します。 

4.5.1 プロジェクトのアーカイブ 

メニューバーの Projectで「Archive Project」をクリックすると、」プ

ロジェクトのアーカイブ」ダイアログボックスが表示されます(図 4-41)。

オプションの上にマウスを置くとその説明が表示されます。 

 Archive File Nameはアーカイブされたファイルのファイル名です。

デフォルトは、アーカイブされる現在のプロジェクト名と同じです。

拡張子は.garです。 

 「Create In」は、アーカイブされたファイルの保存パスです。デフォ

ルトでは、現在のプロジェクトパスです。 

 アーカイブされたプロジェクトの項目には、Project source files(デフ

ォルトでチェックを入れる)、GowinSynthesis files、PnR files、およ

び Programming filesが含まれます。 

- Project source files：プロジェクトパス/srcの下にあるすべてのフ

ァイルが含まれます。 

- GowinSynthesis files：プロジェクトパス/impl/gwsynthesisの下に

ある、合成後のプロジェクトファイル（* .prj）、ネットリスト・

ファイル（* .vg）、合成レポート（* _syn.rpt.html）、リソース統計

ファイル（*_syn_rsc.xml）が含まれます。 

- PnR files：プロジェクトパス/impl/pnrの下にある、配置配線後の

ファイルが含まれます。 

- Programming files：プロジェクトパス/impl/pnrの下にある、配置

配線後のビットストリームファイル*.fs 、*.bin、および*.binxが

http://cdn.gowinsemi.com.cn/SUG502J.pdf
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含まれます。 

 アーカイブされたプロジェクトを選択すると、現在のプロジェクトの

下にある当該項目のソースファイル、パス、およびサイズが表示され

ます。 

 Addボタンと Removeボタンを使用して、アーカイブされたファイル

を追加および削除できます。 

 Archiveをクリックした後、プロジェクト内のファイルが保存されて

いない場合、警告メッセージが表示されます。 

 アーカイブした後、アーカイブが成功または失敗したことを示すウィ

ンドウがポップアップします。 

 アーカイブした後、Create Inパスの下に、アーカイブされたプロジ

ェクト* .garと、garと同じ名前のアーカイブされたファイル* .garlog

の 2つのファイルが生成されます。拡張子が.garのファイルはすべて

のアーカイブされたファイルを圧縮したファイルであり、ログファイ

ル* .garlogは、どのファイルが正常にアーカイブされているかを確認

できます。 

図 4-41 Archive Projectダイアログボックス 

 

4.5.2 アーカイブされたプロジェクトの復元 

メニューバーProjectの「Restore Archived Project」をクリックする

と、アーカイブされたプロジェクトの復元のダイアログボックスが表示さ

れます(図 4-42)。  
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図 4-42 Restore Archived Projectダイアログボックス 

 
 

「Archived File」の右側にあるパス選択ボタンをクリックして、復元

したいアーカイブされたファイルを選択します。復元したいアーカイブさ

れたファイルを選択すると、「Destination Folder」がアーカイブされたフ

ァイルの保存パスに自動的に更新されます。OKをクリックすると、正常

に復元したことを示すダイアログボックスが表示されます。 

4.6 ソフトウェアの終了 

終了方法は次のとおりです。 

1. 「File>Exit」オプションをクリックします。 

2. ソフトウェアインターフェースの右上隅にある「 」アイコンをク

リックします。 

注記： 

 未保存のファイルがある場合、ファイルを保存するかメッセージが表示されま

す。 

 ソフトウェアでの保存(Save)、すべて保存(Save All)、名前を付けて保存(Save 

As…)は、テキスト編集についてのことです。 

 ソフトウェアによるプロジェクト構成情報の変更またはプロジェクト内のファ

イルの追加と削除は、プロジェクト構成ファイルにすぐには保存されず、ソフ

トウェアを閉じると自動的に保存されます。 

 ソフトウェアが実行中の場合、上記の方法でソフトウェアを終了できません。
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5Gowinソフトウェアの統合ツール 

5.1 物理制約エディタ 

FloorPlannerは GOWINセミコンダクターが市場向けに独自に研究開

発した物理制約エディタです。I/O、プリミティブ、Block（BSRAM、

DSP）、Groupなどの属性及び位置情報の読み出しと編集をサポートする

と同時に、ユーザーの構成に基づき新しい配置ファイルと制約ファイルを

生成できます。これらのファイルは、I/Oの属性情報と位置情報、プリミ

ティブや Groupの位置情報などを指定しています。FloorPlannerは、シ

ンプルで使いやすい配置および制約編集機能を提供して、物理制約ファイ

ルの作成の効率を向上させると同時に、デバイスの配置およびタイミング

パスに従ってタイミングの最適化を実行できます。 

FloorPlannerを起動するには、以下の 2つの方法があります： 

1. FPGAプロジェクトを未作成の場合、ソフトウェアメニューの

「Tools」ドロップダウン・リストから「FloorPlanner」を選択できま

す。この場合、File > New…によってネットリスト及び必要なデバイ

ス情報をロードする必要があります。 

2. FPGAプロジェクトの作成時、プロセス管理エリアで合成を実行して

「FloorPlanner」をダブルクリックします。この場合、Floorplannerは

プロジェクトファイルをロードし、Floorplannerの GUIに表示しま

す。FloorPlannerには、Summary、Netlist、Chip Array、Package 

View、および各制約ウィンドウがあります(図 5-1、図 5-2)。 

注記： 

 このツールの使用方法の詳細については、『Gowin物理制約ユーザーガイド

(SUG935)』および『Arora Ⅴ物理制約ユーザーガイド SUG1018)』を参照して

ください。 

 また、FloorPlannerによりタイミングの最適化を行うことができます。 

http://cdn.gowinsemi.com.cn/SUG935J.pdf
http://cdn.gowinsemi.com.cn/SUG1018J.pdf
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図 5-1 Chip Arrayウィンドウ 

 

 

図 5-2 Package Viewウィンドウ 

  

5.2 タイミング制約エディタ 

タイミング制約エディタ(Timing Constraint Editor)は、GOWINセミ
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コンダクターが市場に向けて独自に研究開発したタイミング制約編集ツー

ルです。クロック制約、入力出力制約、パス制約、クロックレポート制約

などを含む複数のタイミング制約コマンドの編集をサポートします。

Timing Constraints Editorは、シンプルで便利なタイミング制約編集機能

を提供し、GOWINセミコンダクターの各 FPGAデバイスをサポートしま

す。 

Timing Constraints Editorを起動するには、2つの方法があります。 

1. FPGAプロジェクトを未作成の場合、メニューで「Tools>Timing 

ConstraintsEditor」を選択します。この場合、「File > New…」でネッ

トリスト・ファイルをロードする必要があります。 

2. FPGAプロジェクトを作成済みの場合、プロセス管理エリアで合成を

実行して「Timing Constraints Editor」をダブルクリックすると、

Timing Constraints Editorはプロジェクトファイルをロードし、Gowin 

Timing Constraints Editorインターフェースに表示されます(図 5-3)。 

注記： 

タイミング制約エディタの詳細については、『Gowinタイミング制約ユーザーガイド

(SUG940)』を参照してください。 

図 5-3タイミング制約作成インターフェース 

  

5.3 IP Core Generator 

IP Core Generatorは、Gowin FPGAに基づく IP(ハードコアとソフト

コアを含む)生成ツールです。IP Core Generatorを介して設計が生成され

た後、ユーザーはそのインスタンス化されたモジュールを利用して設計に

必要な機能を実現し、複雑な設計を実現できるようになります。その主な

機能は次のとおりです(図 5-4)。 

 Soft IP coreと Hard module情報のプレビューをサポート。 

 Soft IP coreと Hard moduleのカスタマイズをサポート。 

http://cdn.gowinsemi.com.cn/SUG940J.pdf
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 Hard moduleのインスタンス化のサンプルケースの生成をサポート。 

 ユーザーの設定を自動的に保存することをサポート。 

 IP生成言語の選択が可能。 

 Soft IPの一部は、テストベンチファイルの自動生成をサポート。 

 デバイスに応じて利用可能な IPを表示。 

図 5-4 IP Core Generatorウィンドウ 

 

 

メニューの Toolsドロップダウン・リストから「IP Core Generator」

をクリックし、IP Core Generatorツールを起動して IPを呼び出します。

その関連ドキュメントは次のとおりです。 

 ADCの生成については、『Gowinプリミティブ ユーザーガイド

(SUG283)』および『Arora V ADCユーザーガイド(UG299)』を参照

してください。 

 BANDGAPの生成については、『Gowinプリミティブ ユーザーガイド

(SUG283)』を参照してください。 

 クロックリソースの生成については、『Gowin Clockユーザーガイド

(UG286)』および『Arora V Clockユーザーガイド(UG306)』を参照し

てください。 

 DSPの生成については、『Gowin DSPユーザーガイド(UG287)』およ

び『Arora V DSPユーザーガイド(UG305)』を参照してください。 

 I3Cの生成については、『Gowinプリミティブ ユーザーガイド

(SUG283)』を参照してください。 

 入出力ロジック（IO Logic）の生成については、『Gowinプログラマ

ブル汎用 IO(GPIO)ユーザーガイド(UG289)』および『Arora Vプログ

http://cdn.gowinsemi.com.cn/UG283J.pdf
http://cdn.gowinsemi.com.cn/UG299J.pdf
http://cdn.gowinsemi.com.cn/UG283J.pdf
http://cdn.gowinsemi.com.cn/UG286J.pdf
http://cdn.gowinsemi.com.cn/UG306J.pdf
http://cdn.gowinsemi.com.cn/UG287J.pdf
http://cdn.gowinsemi.com.cn/UG305J.pdf
http://cdn.gowinsemi.com.cn/UG283J.pdf
http://cdn.gowinsemi.com.cn/UG289J.pdf
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ラマブル汎用 IO(GPIO)ユーザーガイド(UG304)』を参照してくださ

い。 

 メモリ(BSRAM&SSRAM)の生成については、『Gowin BSRAM & 

SSRAMユーザーガイド(UG285)』および『Arora V BSRAM & 

SSRAMユーザーガイド(UG300)』を参照してください。 

 User Flashの生成については、『Gowin User Flashユーザーガイド

(UG295)』を参照してください。 

 SPMIの生成については、『Gowinプリミティブ ユーザーガイド

(SUG283)』を参照してください。 

 ソフトコア IPのリファレンス・デザイン：

https://www.gowinsemi.com/en/support/ip/。 

注記： 

グレーの Hard Moduleまたは Soft IP Coreは現在の deviceにサポートされていませ

ん。 

5.4 Gowinアナライザオシロスコープ 

Gowinアナライザオシロスコープ(GAO)は、GOWINセミコンダクタ

ーが独自に研究開発したデジタル信号解析ツールで、ユーザーが設計内の

信号間のタイミング関係をより簡単に解析し、システムの分析と故障発見

を速やかに実行し、設計効率を高められるよう設計されています。 

GAOは RTLレベルの信号キャプチャとネットリストレベルの信号キ

ャプチャをサポートし、Standard版と Lite版が提供されています。

Standard GAOは最大 16の機能コアをサポートします。各コアは 1つ以

上のトリガポートをサポートし、マルチレベルの静的または動的トリガ式

をサポートします。Lite GAOは、トリガ条件を設定する必要がなく、簡

単に構成できます。さらに、Lite GAOは信号の初期値もキャプチャでき

るため、電源投入時の動作状態の分析を容易にしています。キャプチャさ

れた信号の波形をエクスポートできます。*.csv、*.vcd、および*.prnの 3

つのファイル形式のエクスポートをサポートしています。*.csvと*.prn

は、Matlabなどのサードパーティのシミュレーションツールで直接使用

できます。*.vcdは、ModelSimで使用できます。 

注記： 

Matlabまたは ModelSimを使用するには、対応する承認が必要です。 

GAOには Gowin Core Inserterと Gowin Analyzer Oscilloscopeの 2

つのツールが含まれています。Gowin Core Inserterは主に位置情報を設

計に挿入することに使用され、これらの位置情報は主にサンプリングクロ

ック、トリガユニット、トリガ式を基礎にしています。Gowin Analyzer 

Oscilloscopeは JTAGポートを通じてソフトウェアとターゲットハードウ

ェアに接続し、Gowin Core Inserterの設定したサンプリング信号データ

を直感的に波形で表示します。 

GAOを起動する前に、プロジェクト管理エリアで GAO構成ファイ

http://cdn.gowinsemi.com.cn/UG304J.pdf
http://cdn.gowinsemi.com.cn/UG285J.pdf
http://cdn.gowinsemi.com.cn/UG300J.pdf
http://cdn.gowinsemi.com.cn/UG295J.pdf
http://cdn.gowinsemi.com.cn/UG283J.pdf
https://www.gowinsemi.com/en/support/ip/
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ル(.gao)を新規作成する必要があります。図 5-5は Standard版の GAOの

構成画面です。 

図 5-5 GAO構成ファイルウィンドウ 

 

 

構成ファイルの作成後、メニューで「Tools>Gowin Analyzer 

Oscilloscope」を選択し、オンライン・ロジック・アナライザを開きます

(図 5-6)。 

注記： 

GAOの構成と使用方法については、『Gowinアナライザオシロスコープ ユーザーガ

イド(SUG114)』を参照してください。 

図 5-6 GAOの GUI 

 

http://cdn.gowinsemi.com.cn/SUG114J.pdf
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5.5 Gowinパワーアナライザ 

GOWINパワーアナライザ(GPA)は、豊富な設定オプションによって

できる限り正確な電力解析を提供します。ユーザーは、プロジェクトの実

際の状況に基づき、消費電力に影響するチップの型番、動作環境、信号の

トグルレートなどのパラメータを設定することができます。パワーアナラ

イザはこれらのパラメータに基づき、ユーザーデザインの消費電力を自動

的に予測し、電力解析レポートを生成します。 

現在、GPAツールの起動はまず構成ファイル(.gpa)の新規作成を基礎

としています。以下はその手順です。 

1. ソフトウェアのプロジェクト管理エリア(Design)で「File>New…」を

クリックし、「New」ダイアログを開きます。 

2. 「GPA Config File」を選択し、ポップアップするダイアログボックス

に「Name」を入力します。 

3. 「OK」をクリックすると、「Design」ウィンドウに新規作成された

GPA Config File が表示されます。 

4. ファイル名をダブルクリックし、ソースファイル編集エリアで GPA

構成ファイルを構成することができます(図 5-7)。 

注記： 

GPAの構成と使用法については、『Gowinパワーアナライザ ユーザーガイド

(SUG282)』を参照してください。 

http://cdn.gowinsemi.com.cn/SUG282J.pdf
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図 5-7 GPA構成ファイルウィンドウ 

 

5.6 メモリ初期化ファイルエディタ  

メモリ初期化ファイルは ASCIIファイルで、拡張子は.miです。ユー

ザーは、必要に応じて、メモリの各アドレスにある初期値を指定するため

の、対応形式の初期化ファイルを生成することができます。すでに.miフ

ァイルがある場合は、IDEでメモリ初期化ファイルエディタを使用し

て.miファイルを開き、再度編集して保存できます。 

メモリ初期化ファイルのファイル名は*.mi(file_name.mi)で、ファイ

ルの 1行は 1つのメモリユニットを表します。行の数はメモリユニット

の数で、メモリのアドレス深さ(Address Depth)を表します。列の数は各

メモリユニットのビット数、つまりメモリのデータ幅(Data Width)を表し

ます。アドレスは上から下に順番に増え、各データは上位が前、下位が後

にあります。 

Gowinのメモリ初期化ファイルの編集は、新規作成される.miファイ

ルに基づきます。詳しくは、『Gowin BSRAM & SSRAMユーザーガイド

(UG285)』および『Arora V BSRAM & SSRAMユーザーガイド(UG300)』

を参照してください。初期化ファイルエディタの具体的な手順は次のとお

りです。 

http://cdn.gowinsemi.com.cn/UG285J.pdf
http://cdn.gowinsemi.com.cn/UG300J.pdf
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1. ソフトウェアのプロジェクト管理エリア(Design)で「File>New…」を

クリックし、「New」ダイアログを開きます。 

2. 「Memory Initialization File」を選択します(図 5-8)。「OK」をクリッ

クし、ポップアップする New Fileダイアログボックスで初期化ファ

イル名を入力して「OK」をクリックします(図 5-9)。 

3. 図 5-10のような初期化ファイル構成画面を起動し、ウィンドウの左

側の表に初期値を入力し、右側で初期化ファイルのサイズとビュー形

式を構成します。 

4. 構成画面の右側で初期化ファイルの DepthとWidthを構成し、左側の

表でアドレスと初期値の数値表示形式を構成します。 

 DepthとWidthは、ユーザーが IP Core Generatorウィンドウで

選択した Block Memoryまたは Shadow Memoryの Address 

Depth及び Data Widthと一致させる必要があります。初期化ファ

イルの Address Depthまたは Data Widthがウィンドウで選択し

た値より大きい場合、IP Core Generatorはエラーメッセージを表

示します。ウィンドウで選択した値より小さい場合、未指定のア

ドレスの値がデフォルトで 0に初期化されます。設定後、

「Update」をクリックします。 

 左側の表のアドレスと数値は、バイナリ、16進数、アドレス付き

16進数などの形式で表示できます。 

5. 構成画面の左側の表に初期値を入力します。この表では、表のビュー

形式も設定できます。表のヘッダを右クリックすると、列数の表示を

構成できます。 

 1、8、16の 3つから選択できます(図 5-11)。 

 表の初期値は、ダブルクリックして手入力するか、右クリックす

ることで設定できます。値を入力する場所を右クリックして、

「Fill with 0」は、初期値の各ビットを 0にすることを表し、「Fill 

with 1」は初期値の各ビットを 1にすることを表します。

「Custom Fill」の場合、ユーザーは必要に応じて数を入力する

か、初期値を一括設定できます(図 5-12)。 

6. ファイルを保存します。 
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図 5-8初期化ファイルの新規作成 

 

 

図 5-9 New Fileダイアログボックス 

 

 

図 5-10初期化ファイル構成ウィンドウ 
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図 5-11列数の構成 

 

 

図 5-12一括設定 

 

5.7 User Flash初期化ファイルエディタ  

User Flash初期化ファイルは ASCIIファイルで、拡張子は.fiです。

ユーザーは、必要に応じて、User Flashの各アドレスにある初期値を指

定するための、対応形式の初期化ファイルを生成することができます。す

でに.fiファイルがある場合は、ソフトウェアで User Flash初期化ファイ

ルエディタを使用して.fiファイルを開き、再度編集して保存できます。 

User Flash初期化ファイルのファイル名は*.fi(file_name.fi)で、ファイ

ルの 1行は 1つのメモリユニットを表します。行の数はメモリユニット

の数です。行頭の角括弧内の内容は、セミコロンで区切られた縦座標アド

レスと横座標アドレスです。各行の角括弧の後の内容は、メモリユニット

の初期化データです。2進数と 16進数のデータをサポートします。各デ

ータの上位が前、下位が後になります。.fiファイルの形式の例は次のとお

りです。 

5.7.1 2進数形式(Bin File) 

 Binファイルはバイナリ数 0と 1から成るテキストファイルです。 

//Copyright (C)2014-2024 Gowin Semiconductor Corporation. 

//All rights reserved. 

//File Title: User Flash Initialization File 

//Tool Version: V1.9.10(64-bit) 

//Part Number: GW1N-LV4PG256C6/I5 

//Device-package: GW1N-4-PBGA256 

//Device Version: D 

//Flash Type: FLASH256K 

//File Format: Bin 



5Gowinソフトウェアの統合ツール  5.7User Flash初期化ファイルエディタ 

 

SUG100-4.4.2J 79(157) 

 

//Created Time: 2024-06-28 14:31:12 

[0:0] 00000000000100000001000100010000 

[1:1] 00000000000100010001000000000001 

5.7.2 16進数形式(Hex File) 

 Hexファイルは Binファイル形式と類似し、そのデータは 16進数

の 0~Fで構成されます。 

//Copyright (C)2014-2024 Gowin Semiconductor Corporation. 

//All rights reserved. 

//File Title: User Flash Initialization File 

//Tool Version: V1.9.10 (64-bit) 

//Part Number: GW1N-LV4PG256C6/I5 

//Device-package: GW1N-4-PBGA256 

//Device Version: D 

//Flash Type: FLASH256K 

//File Format: Hex 

//Created Time: 2024-06-28 14:41:24 

[0:0] 00101110 

[1:1] 00111001 

GOWIN User Flash初期化ファイルの編集は、新規作成される.fiファ

イルに基づきます。以下は、初期化ファイルエディタの使用手順です。 

1. ソフトウェアのプロジェクト管理エリア(Design)で「File>New…」を

クリックし、「New」ダイアログを開きます。 

2. 「User Flash Initialization File」を選択します(図 5-13)。「OK」をクリ

ックし、ポップアップする New Fileダイアログボックスで初期化フ

ァイル名を入力した後、デバイスを選択して「OK」をクリックしま

す(図 5-14)。そのうち.fiファイルのデフォルトパスはプロジェクトデ

ィレクトリの srcフォルダです。現在、User Flash初期化ファイルエ

ディタでサポートされているデバイスは、User Flashプリミティブで

サポートされているデバイス情報と一致しています。User Flashをサ

ポートしていないデバイスが選択された場合、「Current device do not 

support flash」というメッセージがダイアログボックスの下部に表示

されます。 
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図 5-13初期化ファイルの新規作成 

 

図 5-14 New Fileダイアログボックス 

 

 

3. 図 5-15のような初期化ファイル構成画面を起動し、ウィンドウの左

側の表に初期値を入力し、右側で初期化ファイルのサイズとビュー形

式を構成します。また、Part Number情報および User Flashのモデ

ルも確認できます。 

図 5-15初期化ファイル構成ウィンドウ 
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4. 構成画面の右側でチップの型番、初期化ファイルの形式を構成し、左

側の表でアドレスと初期値の数値表示形式を構成します。 

 Part Number情報をクリックすると、「Select Device」ダイアログ

ボックスがポップアップし、別の型番を選択できます。 

 左側の表でアドレスと数値の表示形式をバイナリ、8進数、10進

数、16進数などの形式から選択できます。 

5. 構成画面の左側の表に初期値を入力します。この表では、表のビュー

形式も設定できます。表の初期値は、ダブルクリックして手入力する

か、右クリックすることで設定できます。値を入力する場所を右クリ

ックして、「Fill with 0」は、初期値の各ビットを 0にすることを表

し、「Fill with 1」は初期値の各ビットを 1にすることを表します。

「Fill Custom」の場合、ユーザーは必要に応じて数を入力するか、初

期値を一括設定できます(図 5-16)。 

図 5-16一括設定 

 

 

6. ファイルを保存します。 

5.8 回路図ビューア 

回路図ビューア(Schematic Viewer)を使用することでデザインの論理

構造を直感的に理解できます。Schematic Viewer(RTL Design Viewerと

Post-Synthesis Netlist Viewerを含む)は、加算器、乗算器、レジスタ、

ANDゲート、NOTゲート、インバータなど、一般的な回路図記号を使用

します。 

メニューバーの「Tools」ドロップダウン・リストから「Schematic 

Viewer-RTL Design Viewer」または「Schematic Viewer-Post-Synthesis 

Netlist Viewer」をクリックすると、それぞれ RTL設計の回路図または合

成後ネットリストの回路図が表示されます。「RTL Design Viewer 」ウィ

ンドウと「Post-Synthesis Netlist Viewer」ウィンドウは、それぞれ図 5-17

と図 5-18に示すとおりです。 
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図 5-17 RTL Design Viewerウィンドウ 

 

 

図 5-18 Post-Synthesis Netlist Viewerウィンドウ 

 

 

Schematic Viewerのツールバーには、戻る「 」、進む「 」、ズー

ムイン 「 」、ズームアウト「 」、ズームフィット「 」、トップレベ

ルビュー 「 」、アッパーレベルビュー「 」、リロード「 」、および検

索「 」があります。Modules、Ports、Nets、Primitives、および Black 

Boxesなど、デザインを構成する論理要素がウィンドウの左側に表示され

ます。 

注記： 

Schematic Viewerの詳細については、『Gowin HDL回路図ビューア ユーザーガイド

(SUG755)』を参照してください。 

5.9 仮想入出力デバッグ・ツール 

Gowin仮想入出力(GVIO)コアは、内部 FPGA信号をリアルタイムで

監視および駆動できるカスタマイズ可能なコアです。その入力ポートは、

http://cdn.gowinsemi.com.cn/SUG755J.pdf
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FPGA信号の監視に使用され、仮想 LEDに相当します。その出力ポート

は、FPGA信号の駆動に使用され、仮想スイッチに相当します。 

GVIOを起動する前に、プロジェクト管理エリアで GVIO構成ファイ

ルを新規作成する必要があります。GVIO構成ファイルの画面は図 5-19

に示すとおりです。 

図 5-19 GVIO構成ファイルウィンドウ 

 

注記： 

Gowin仮想入出力(GVIO)コアの構成と使用については、『Gowin Virtual Input Output

ツール ユーザーガイド(SUG1189)』を参照してください。 

5.10 アイ・ダイアグラム分析ツール GoBert 

アイ・ダイアグラム分析ツール GoBertは、Gowinが独自に開発し

た、SerDes受信信号のアイ・ダイアグラムを解析するツールです。この

ツールは、ユーザーが SerDes受信品質を解析し、ユーザーデザインのパ

フォーマンスと信頼性を向上できるように設計されています。GoBertを

使用して受信信号の品質をテストするには、開発ボードに顧客のプログラ

ムをロードする必要があります。アイ・ダイアグラム・テストは、顧客の

プログラムが正常に実行できる場合にのみ開始できます。 

Gowinソフトウェアのツールバー > 「 」またはメニューバー > 

「Tools」 > 「 」をクリックして、GoBertウィンドウを起動します(図

5-20)。 

http://cdn.gowinsemi.com.cn/SUG1189J.pdf
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図 5-20 GoBertウィンドウ 

 

注記： 

GoBertの構成と使用法については、『Gowin GoBertツール ユーザーガイド

(SUG1198)』を参照してください。 

http://cdn.gowinsemi.com.cn/SUG1198J.pdf
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6ファイルの出力 

Gowinソフトウェアは、FPGA設計プロセスにおいてビットストリ

ームファイルに加えて、ユーザーの参考として、さまざまなレポートを生

成することができます。デフォルトで生成されるレポートには、合成レポ

ート、配置配線レポート、ポート属性レポート、タイミングレポート、お

よび電力解析レポートなどがあります。また、ユーザーは Place & Route

を右クリックし、構成オプションを変更してピン制約ファイル、タイミン

グシミュレーション・モデルファイルなどを生成できます。 

6.1 合成レポート 

GowinSynthesisによる合成が完了すると、対応する合成レポートと

ネットリスト・ファイルが生成されます。 

Synthesis Message、Synthesis Details、Resource、Timingを含む、

*_syn.rpt.htmlという合成レポートが生成されます(図 6-1)。 

図 6-1 GowinSynthesisの合成レポート 
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レポートの左側には、以下に示すように、特定のインデックス情報が

表示されます。 

 Synthesis Message：合成レポートの基本情報。主に、合成されたデ

ザインファイル、制約ファイル、ソフトウェアのバージョン番号、デ

バイス情報、レポート作成時間、および法的通知に関する情報が含ま

れます。 

 Synthesis Details：設計ファイルのトップ・モジュール、合成の各サ

ブステージの実際の実行時間, CPU実行時間, ピークメモリ使用量、

合成全体 CPU実行時間とピークメモリ使用量。 

 Resource：リソース使用量の情報。 

 Timing：Clock Summary、Max Frequency Summary、Detail Timing 

Paths Informationsなどの情報を含むタイミング解析レポート。 

6.2 配置配線レポート 

配置配線レポートには、ユーザーデザインが占有するチップリソース

情報、メモリ使用情報、時間使用情報などが記載されます。これにより、

ユーザーはデザインのサイズと、ターゲットチップと一致するかどうかを

確認できます。ファイルの拡張子は.rpt.htmlで、詳細は*.rpt.htmlファイ

ルを参照してください。 

ユーザーはプロセス管理エリアの Place & Routeエリアで、「Place & 

Route Report」をクリックすると、FPGAプロジェクトに対応する配置配

線レポートを開きます(図 6-2)。 

図 6-2 Place & Route Report 

  
 

配置配線レポートの左側には、以下に示すように、特定のインデック

ス情報が表示されます。 
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 PnR Messages：配置配線レポートの概要情報。レポート名、設計例

のパスと名前、物理制約ファイル、タイミング制約ファイル、ソフト

ウェアバージョン番号、デバイス情報、レポート作成時間、法的声明

など。 

 PnR Details： 

- 配置の各段階で費やされた時間と配置の合計時間。プロジェクト

に GAOがある場合は、GAO配置の時間が含まれます。 

- 配線の各段階で費やされた時間と配線の合計時間。プロジェクト

に GAOがある場合は、GAO配線の時間が含まれます。 

- 出力ファイルの作成にかかる時間。 

 Resource：以下の項目が含まれます： 

- Resource Usage Summary：ユーザーデザインのリソース使用量

情報。 

- I/O Bank Usage Summary：ユーザーデザインで使用される I/O 

Bankの情報。 

- Global Clock Usage Summary：ユーザーデザイン使用されるグロ

ーバル・クロック情報。 

- Global Clock Signals：ユーザーデザインで使用されるグローバ

ル・クロック信号。 

- Pinout by Port Name：ポートに対応するピンアウト情報。 

- All Package Pins：現在のパッケージのすべてのピン。 

プロジェクトに GAOがある場合は、GAO Resource Usage 

Summaryが含まれます：ユーザーデザインの GAOのリソース使用量

情報。 

6.3 ポート属性レポート 

ポート属性レポートは、配置後に出力されるポート属性のファイル

で、ポートのタイプ、属性、ポート位置情報などが含まれます。生成され

るファイルの拡張子は.pin.htmlで、詳細については*.pin.htmlファイルを

参照してください。 

ユーザーは、プロセス管理エリアの Place & Routeエリアで「Ports 

& Pins Report」をダブルクリックし、FPGAプロジェクトに対応するポ

ート属性レポートを開くことができます(図 6-3)。 
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図 6-3 Ports & Pins Report 

  
 

ポート属性レポートの左側には、インデックス情報が表示されます。 

 Pin Messages：ポート属性レポートの概要情報。レポート名、設計例

のパスと名前、物理制約ファイル、タイミング制約ファイル、ソフト

ウェアのバージョン番号、デバイス情報、レポート作成時間、法的通

知など。 

 Pin Details：以下の項目が含まれます： 

- Pinout by Port Name：ポートに対応するピンアウト情報。 

- All Package Pins：現在のパッケージのすべてのピン。 

注記： 

GW1N-1P5/GW1N-2/GW1NR-2および GW2AN-18X/GW2AN-9X以外のデバイスで

は、Bank VCCIOの制約を追加しないと、一部のシングルエンド入力ポートの IO 

Typeに対応する電圧値は、ポート属性レポートの Bank VCCIOの値と一致しない場合

があります(これは正常です)。例えば、レポート内の IO Typeは LVCMOS18(電圧値

1.8に対応)ですが、Bank VCCIOは 1.2です。 

6.4 タイミングレポート 

タイミングレポートは、回路のネットリストに全面的な解析を行い、

回路のタイミングパス遅延を計算し、要件を満たすか判断します。タイミ

ングレポートには、セットアップ時間チェック、ホールド時間チェック、

リカバリ時間チェック、リムーバル時間チェック、最小クロックパルスチ

ェック、最大ファンアウトパス、配線密集レベルレポートなどが含まれま

す。デフォルトでは上記のすべてのチェックについて報告するほか、最大

周波数のレポートも提供します。 

ユーザーは、プロセス管理エリアの Place & Routeエリアで「Timing 

Analysis Report」をダブルクリックし、FPGAプロジェクトに対応するタ

イミングレポートを開くことができます(図 6-4)。 
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注記： 

タイミングレポートの詳細については、『Gowinタイミング制約ユーザーガイド

(SUG940)』を参照してください。 

図 6-4タイミングレポート内容 

  

6.5 消費電力解析レポート 

電力解析レポートは、主にユーザーデザインのために提供されます。

電力解析の際、デバイスの特性に基づいて推定消費電力計算が行われま

す。これにより、ユーザーがデザインの基本的な消費電力値を評価できま

す。 

ユーザーは、プロセス管理エリアの Place & Routeエリアで「Power 

Analysis Report」をダブルクリックし、FPGAプロジェクトに対応する電

力解析レポートを開くことができます(図 6-5)。 

注記： 

電力解析の詳細については、『Gowinパワーアナライザ ユーザーガイド(SUG282)』

を参照してください。 

図 6-5電力解析レポート 

http://cdn.gowinsemi.com.cn/SUG940J.pdf
http://cdn.gowinsemi.com.cn/SUG282J.pdf
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7 シミュレーションファイル 

Gowinソフトウェアは、シミュレーション用の入力ファイルを提供し

ます。シミュレーションには、機能シミュレーションとタイミングシミュ

レーションがあります。機能シミュレーションは、プレレイアウト・シミ

ュレーションとも呼ばれます。機能シミュレーションの主な目的は、回路

の機能が設計要件を満たしているかどうかを確認することです。その特徴

は、回路のゲート遅延や配線遅延を考慮しないことです。 

タイミングシミュレーションは、ポストレイアウト・シミュレーショ

ンとも呼ばれます。タイミングシミュレーションでは、回路がマッピング

された後、回路のパス遅延とゲート遅延が包括的に考慮され、回路が特定

のタイミング条件下で設計に適合しているかどうかが検証されます。 

7.1 機能シミュレーションファイル 

機能シミュレーションには、合成前のユーザーRTL設計機能シミュレ

ーションと合成後の論理ネットリスト機能シミュレーションが含まれま

す。必要なファイル(Verilogでのデザインの場合)は、合成前のユーザー設

計 RTLファイル、合成後のネットリスト・ファイル（* .vg）、テストベン

チファイル（testbench）* tb.v、および機能シミュレーション・ライブラ

リ・ファイル prim_sim.vです。 

注記： 

 シミュレーション・ライブラリ・ファイルのパス：installPath¥IDE¥simlib。 

 VHDLを使用した場合、シミュレーション・ライブラリ・ファイルは

prim_sim.vhdです。 

 生成されるソフトコア IPは暗号文であるため、デザインにソフトコア IPが含

まれている場合、ソフトコア IP生成後の.vo/.vhoファイルを機能シミュレーシ

ョンファイルとして使用する必要があります。.vo/.vhoファイルは現在のプロジ

ェクトディレクトリ src¥ipNameにあります。 

7.2 タイミングシミュレーションファイル 

タイミングシミュレーションに必要なファイル(Verilogを使用する場

合)：ソフトウェアによって生成された Verilogタイミングシミュレーショ

ン論理ネットリスト・ファイル* .vo、対応する遅延ファイル* .sdf、対応
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するテストベンチファイル* tb.v、およびタイミングシミュレーション・

ライブラリ・ファイル prim_tsim.vです。 

注記： 

sdfファイル内の遅延データの時間精度は 1psです。 

タイミングシミュレーション論理ネットリスト・ファイル* .voおよび

遅延ファイル* .sdfは、Gowinソフトウェアの GUIを介してプロジェクト

を実行することで生成できます。その手順は次のとおりです。 

1. プロジェクトを作成/開いた後、Project > Configuration > Place & 

Routeオプションで「Generate SDF File」と「Generate Post-PNR 

Verilog Simulation Model File」の値を Trueに設定し、「OK」をクリッ

クします(図 7-1)。 

図 7-1オプションの構成 

 
 

2. Place＆Routeを実行します。正常に実行された後、プロジェクトのパ

スの下の impl/pnr/に必要な voファイルと sdfファイルが現れます。
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8Tclコマンドの説明 

    Gowinソフトウェアは、コマンド・ライン・モードでの実行をサポート

します。以下の説明では、山括弧<>に含まれているコンテンツは必須コン

テンツであり、角括弧[]に含まれているコンテンツはオプションのコンテン

ツです。「/」、「*」、「-」、スペースなどの特殊文字を含むファイル名はサポー

トされていません。数字で始まる IP module_nameはサポートされていませ

ん。 

8.1コマンド・ライン・モードを開始 

8.1.1 gw_sh.exe 

構文 

 コマンド：例えば、Windowsの場合、インストール・ディレクトリ

の¥x.x¥IDE¥bin¥gw_sh.exeを起動します。 

 パラメータ： 

     [script file] 

パラメータなし：コマンドラインコンソール・モードに直接入りま

す。 

script file：指定されたスクリプトファイルを実行します(オプショ

ン)。 

応用例 

 #コマンド・ライン・モードを開始 

 gw_sh.exe  

 #スクリプトファイルを実行します。具体的な例については、『Gowin

ソフトウェア クイックスタートガイド(SUG918)』の「Tclコマンドのク

イックスタート」セクションを参照してください。 

 gw_sh.exe script_file 

http://cdn.gowinsemi.com.cn/SUG918J.pdf
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8.2コマンド 

8.2.1コマンドの分類 

IPFlow 

Project 

8.2.2コマンド一覧 

IPFlow： 

create_ipc 

generate_target 

get_ips 

list_property 

read_ipc 

report_property 

set_property 

source 

write_ip_tcl 

Project: 

add_file 

create_project 

import_files 

open_project 

rm_file 

run 

run close 

saveto 

set_device 

set_file_enable 

set_file_prop 

set_option 

source 

8.3コマンドの説明 

8.3.1 add_file 

プロジェクトに追加される設計ファイルを指定します。  
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構文 

add_file [-type] [-disable] [-h/--help] <file> 

形式 

名称 説明 

[-type] 追加される設計ファイルのタイプ 

[-disable] 無効な状態に設定します 

[-h/--help] ヘルプ情報を表示します 

<file> 追加されるファイル 

分類 

Project 

説明 

設計ファイルを追加します。Windowsと Linuxオペレーティングシス

テムは、/または¥¥の 2つのファイルパスの区切り文字をサポートしま

す。相対パスと絶対パスをサポートします。相対パスは、Gowinソフト

ウェア GUIでは現在プロジェクトのパスを基準にしており、コマンド・

ライン・モードでは gw_sh.exeが起動された際のパスを基準にしていま

す。 

パラメータ 

 <file>：追加したい設計ファイル。複数指定できます(スペースで区切

ります)。 

 [-type <type>]：add_fileコマンドは、ファイルのサフィックスに基づ

いてファイルタイプを自動的に決定できますが、このオプションを使

用してファイルタイプを直接に指定することもできます。サポートさ

れているファイルタイプ：verilog、vhdl、sv、vg、cst、sdc、gao、

gpa、gscなど。 

 -disable：追加したファイルを無効にします。無効な状態のファイル

はファイルリストに追加されるだけで、実行されることはありませ

ん。関連コマンド：set_file_enable。 

 [-h、--help]：ヘルプ情報を表示します。 

例 

add_file abc.v 

add_file -type vhdl 1.vhd 2.vhdl 3.vhd 

add_file D:/gowin_project/top.v 

add_file D:¥¥gowin_project¥¥top.v 

8.3.2 create_ipc 

デフォルトの構成で ipcファイルを生成します。 
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構文 

create_ipc -name <ipName> -module_name <moduleName> [-
language <arg>] [-file_name <fileName>] [-dir <path>] [-force] 

形式 

名称 説明 

-name IP name 

-module_name 作成されるIPのモジュール名 

[-language] IPファイル、テンプレートファイル、シミュレーシ

ョンファイルの言語 

[-file_name] IPファイルの名前 

[-dir] IP生成パス 

[-force] 既存のファイルを上書きします 

分類 

IPFlow 

説明 

このコマンドは、IP Core Generator内の IPコアの IPCファイルを作

成します。 

パラメータ 

 -name <ipName>：IPの名前を指定します。この名前は、IP Core 

Generatorから取得できます。 

 -module_name <moduleName>：作成される IPのモジュール名を指

定します。 

 [-language <arg>]：生成される IPファイル、テンプレートファイル、

およびシミュレーションファイルの言語 (Verilog/VHDL)を指定しま

す。指定しない場合は、デフォルトで Verilogが使用されます。 

 [-file_name <fileName>]：生成される IPファイルの名前を指定しま

す。指定しない場合は、module_nameで指定された名前と同じにな

ります。 

 [-dir] <path>：IP生成パスを指定します。指定しない場合は、現在の

プロジェクトの srcフォルダーに生成されます。 

 [-force]：既存のファイルを上書きします。 

例 

次の例では、現在のプロジェクトの srcフォルダーに-nameで指定さ

れた IPコアが作成され、モジュール名、言語、ファイル名が指定されま

す。 

create_ip -name fifo -module_name FIFO_Top -language Verilog -
file_name fifo 
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関連項目 

generate_target 

8.3.3 create_project  

プロジェクトを新規作成します。 

構文 

create_project [-name <prjName>] [-dir <path>] [-pn <pnName>] [-
device_version <arg>] [-force] [-h/--help] 

形式 

名称 説明 

[-name] 作成されるプロジェクトの名前 

[-dir] 作成すされるプロジェクトのパス 

[-pn] 作成されるプロジェクトの部品番号 

[-device_version] 作成されるプロジェクトのデバイスバージョン 

[-force] 既存のファイルを上書きします 

[-h/--help] ヘルプ情報を表示します 

分類 

Project 

説明 

プロジェクトを新規作成します。ファイルパスの形式については、

8.3.1 add_fileを参照してください 

パラメータ 

 [-name <prjName>]：作成されるプロジェクトの名前を指定します。 

 [-dir <path>]：作成されるプロジェクトのパスを指定します。指定し

たパスが存在しない場合は、新しいパスが作成されます。このオプシ

ョンが指定されていない場合は、現在のプロジェクトのパスまたは tcl

スクリプトが配置されているパスが使用されます。 

 [-pn <PnName>]：作成されるプロジェクトの Part Number(部品番号)

を指定します。 

 [-device_version <arg>]：Part Numberの device versionを指定しま

す。初期バージョンのみを持つデバイスの場合、device versionの値

は NAです。 

 [-force]：既存のプロジェクトを上書きします。 

 [-h、--help]：ヘルプ情報を表示します。 

例 

create_project -name prj0 -dir D:/tclprj -pn GW1N-UV4LQ144C6/15 -
device_version B 
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create_project -name prjlest -pn GW1N-UV4LQ144C6/15 - 

device_version B -force 

8.3.4 generate_target 

指定されたオブジェクトのターゲット・ファイルを生成します。 

構文 

generate_target <objects> [-force] 

形式 

名称 説明 

<objects> ターゲット・ファイルが生成されるオブジェクトを

指定します。 

[-force] 既存のファイルを上書きします 

分類 

IPFlow 

説明 

このコマンドは、指定された IPオブジェクト(get_ips)のターゲッ

ト・ファイルを生成し、IPコアの設計ファイルを現在のプロジェクトに

追加します。 

パラメータ 

 <objects>：設計ファイルが生成される 1つまたは複数の IPオブジェ

クトを指定します。1つのオブジェクトは[get_ips module_name]で指

定されます。複数のオブジェクトは、[get_ips module_name0 

module_name1 …] で指定されます。 

 [-force]：既存のファイルを上書きします。 

例 

次の例では、指定された IPの設計ファイルとテンプレートファイル

が生成され、現在のプロジェクトに追加されます。 

generate_target [get_ips FIFO_Top] 

関連項目 

 generate_target 

 create_ipc 

 read_ipc 

8.3.5 get_ips 

IPオブジェクトを指定します。 

構文 

get_ips <module_name> 
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形式 

名称 説明 

<module_name> IPの module_nameを指定します 

分類 

IPFlow 

説明 

現在のプロジェクトの IPオブジェクトを指定します。 

パラメータ 

<module_name>：IPオブジェクトの module_name(1つまたは複数)

を指定します。 

例 

次の例では、現在のプロジェクトに 1つの IPオブジェクトが指定さ

れます。 

get_ips FIFO_Top 

次の例では、現在のプロジェクトに複数の IPオブジェクトが指定さ

れます。 

get_ips FIFO_Top FIFO_Top_1 

関連項目 

 generate_target 

 list_property 

 report_property 

 set_property 

8.3.6 import_files 

ファイルまたはディレクトリを現在のプロジェクトにコピーします。 

構文 

import_files [-file <file>] [-dir <path>] [-fileList <fileList>] [-force] [-h/--
help] 

形式 

名称 説明 

[-file] コピーされるファイルを指定します 

[-dir] コピーされるディレクトリを指定します 

[-fileList] ファイルリストを指定します 

[-force] 同じ名前の既存のファイルを上書きします 

[-h/--help] ヘルプ情報を表示します 
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分類 

Project 

説明 

ファイルまたはディレクトリを現在のプロジェクトのパス/srcにコピ

ーします。-file、-dir、および-fileListは、相対パスと絶対パスをサポート

します。相対パスは、Gowinソフトウェア GUIでは現在のプロジェクト

のパスを基準にしており、コマンドラインモードでは tclスクリプトのパ

スを基準にしています。import_filesの後にオプションがない場合は、

add_fileコマンドで指定されたすべてのファイルがプロジェクトのパス

/srcにコピーされます。 

パラメータ 

 [-file <file>]：1つ以上のファイルをプロジェクトのパス/srcに追加し

ます。 

 [-dir <path>]：パスの下にあるすべてのファイルとサブフォルダをプ

ロジェクトのパス/srcに追加します。 

 [-fileList <fileList>]：リストファイルを指定します。ファイル内の各行

は追加されるプロジェクトファイルです。その内容の例は次のとおり

です： 

- D:/test1.v 

- D:/test2.v 

- このオプションにより、ファイル内の各行で指定されたファイル

をプロジェクトのパス/src に追加できます。 

 [-force]：プロジェクトのパス/srcにある同名のファイルを上書きしま

す。 

 [-h/--help]：ヘルプ情報を表示します。 

例 

import_files -file D/test1 .v -force 

import_files -file D:/test1 .v D:/test2.v -force 

import_files -dir D:/sourceFile 

import_files -fileList log。logファイルの内容は次のとおりです：  

D:/Test1.v 

D:/Test2.v 

8.3.7 list_property 

オブジェクトの属性をリストします。 

構文 

list_property <object> 
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形式 

名称 説明 

<object> 属性がリストされるオブジェクト 

分類 

IPFlow 

説明 

指定された IPオブジェクトのすべてのオプションのリストを取得し

ます。 

パラメータ 

<object>：IPオブジェクト。[get_ips module_name]で指定されま

す。 

例 

次の例では、指定された IPオブジェクトのすべての属性がリストさ

れます。 

list_property [get_ips FIFO_Top] 

関連項目 

 report_property 

 set_property 

8.3.8 open_project 

プロジェクトを開きます。 

構文 

open_project <file>] [-pn] [-device_version] [-h/--help] 

形式 

名称 説明 

<file> プロジェクトファイルを指定します 

[-pn] 部品番号を指定します 

[-device_version] プロジェクトのデバイスバージョンを指定します 

[-h/--help] ヘルプ情報を表示します 

分類 

Project 

説明 

プロジェクトを開きます。開くプロジェクトのために新しい部品番号

を指定することができます。ファイルパスの形式については、8.3.1 

add_fileを参照してください。  
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パラメータ 

 <file>：開くプロジェクトファイルの名前を指定します。 

 [-pn]：プロジェクトの部品番号を指定します。 

 [-device_version] ：デバイスのバージョンを指定します。 

 [-h/--help]：ヘルプ情報を表示します。 

例 

open_project D:¥test.gprj 

8.3.9 read_ipc 

ipcファイルを読み出します。 

構文 

read_ipc <file> 

形式 

名称 説明 

<file> IPCファイル 

分類 

IPFlow 

説明 

指定された IPCファイルを読み出します。ファイルパスの形式につい

ては、8.3.1 add_fileを参照してください。 

パラメータ 

<file>：指定される IPCファイルを指定します。 

例 

次の例では、指定された IPCファイルが読み出されいます。 

read_ipc D:/gowin_project/src/fifo/fifio.ipc 

関連項目 

generate_target 

8.3.10 report_property 

オブジェクトの属性を報告します。 

構文 

report_property <object> 
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形式 

名称 説明 

<object> 属性がリストされるオブジェクト 

分類 

IPFlow 

説明 

指定された IPオブジェクトのオプション名、オプションタイプ、お

よびオプション値を取得します。 

パラメータ 

<object>：IPオブジェクト。[get_ips module_name]で指定されま

す。 

例 

次の例では、指定された IPオブジェクトのすべての属性がリストさ

れます。 

report_property [get_ips FIFO_Top] 

関連項目 

 set_property 

 list_property 

8.3.11 rm_file 

設計ファイルを削除します。 

構文 

rm_file [-h/--help ] <files> 

形式 

名称 説明 

<-files> 削除されるファイル 

[-h/--help] ヘルプ情報を表示します 

分類 

Project 

説明 

設計ファイルを削除します。ファイルパスの形式については、8.3.1 

add_fileを参照してください。 

パラメータ 

 <-files>：削除される設計ファイルを指定します。複数指定できます

(スペースで区切ります)。 
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 [-h/--help]：ヘルプ情報を表示します。 

例 

rm_file a.v 

rm_file a.v b.v c.v 

rm_file D:/gowin_project/top.v 

rm_file D:¥¥gowin_project¥¥top.v 

8.3.12 run 

プロセスを実行します。 

構文 

run [-h/--help] <syn/pnr/all> 

形式 

名称 説明 

<syn/pnr/all> 実行されるプロセスを指定します 

[-h/--help] ヘルプ情報を表示します 

分類 

Project 

説明 

プロセスを実行します。 

パラメータ 

 <syn/pnr/all>：実行するプロセスの名前を指定します。実行可能なプ

ロセスの名前は、synおよび pnrであり、それぞれ合成および配置配

線を表します。allを指定して、すべてのプロセスを実行することもで

きます。 

 [-h/--help]：ヘルプ情報を表示します。 

例 

run pnr 

run all 

8.3.13 run close 

プロジェクトを閉じます。 

構文 

run close 

分類 

Project 
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説明 

現在のプロジェクトを閉じます。 

例 

run close 

8.3.14 saveto 

現在のプロジェクトのデータを Tclスクリプトに保存します。 

構文 

saveto [-all_options] [-h/--help] <file> 

形式 

名称 説明 

[-all_options] すべてのオプション情報を保存します 

[-h/--help] ヘルプ情報を表示します 

<file> ファイルの名前 

分類 

Project 

説明 

現在のプロジェクトの設計データを Tclスクリプトに保存します。フ

ァイルパスの形式については、8.3.1 add_fileを参照してください。  

パラメータ 

 [-all_options]： savetoコマンドは、デフォルトでは変更されたオプ

ション情報、つまりデフォルト値とは異なるオプションのみを保存し

ます。-all_optionsを使用して、すべてのオプション情報を保存する

ことができます。 

 [-h、--help]：ヘルプ情報を表示します。 

 <file>： ファイルの名前。 

例 

saveto project.tcl 

saveto -all_options project.tcl 

saveto -all_options D:/gowin_project/project.tcl 

saveto -all_options D:¥¥gowin_project¥¥project.tcl 

8.3.15 set_device 

デバイスの型番を設定します。 

構文 

set_device [-device_version <value>] [-h/--help ] <part number> 
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形式 

名称 説明 

[-device_version <value>] 設定されるデバイスバージョン 

[-h/--help] ヘルプ情報を表示します 

<part number> 設定される部品番号 

分類 

Project 

説明 

デバイスの型番を設定します。 

パラメータ 

 <part number>：ターゲットデバイスの部品番号(例えば、GW1N-

UV4LQ144C6/I5)を指定します。 

 [-device_version<value>]：デバイスのバージョンを指定します。サポ

ートされるバージョンには、NA|B|C|Dがあります。 

 [-h/--help]：ヘルプ情報を表示します。 

例 

set_device GW1N-LV1CS30C6/I5 

set_device –device_version C GW1N-UV4LQ144C6/I5 

8.3.16 set_file_enable 

ファイルのイネーブル属性を設定します。 

構文 

set_file_enable <file> <true|false> [-h/--help]  

形式 

名称 説明 

<file> 設定される設計ファイルを指定します。 

<true|false> ファイルを使用できるかを設定します 

[-h/--help] ヘルプ情報を表示します 

分類 

Project 

説明 

ファイルを使用できるかを設定します。ファイルパスの形式について

は、8.3.1 add_fileを参照してください。 

パラメータ 

 <file>：設定されるファイルを指定します。 



8 Tclコマンドの説明 8.3コマンドの説明 

 

SUG100-4.4.2J 106(157) 

 

 <true | false> ：trueはファイルを使用できることを意味し、falseは

使用できないことを意味します。 

 [-h/--help]：ヘルプ情報を表示します。 

例 

set_file_enable top.v false 

set_file_enable D:/gowin_project/top.v 

set_file_enable D:¥¥gowin_project¥¥top.v 

8.3.17 set_file_prop 

ファイルの属性を設定します。 

構文 

set_file_prop <file> [-lib <name>] [-h/--help]  

形式 

名称 説明 

<file> 設定される設計ファイルを指定します。 

[-lib <name>] ファイルのlibrary nameを設定します。 

[-h/--help] ヘルプ情報を表示します 

分類 

Project 

説明 

ファイルの属性を設定します。ファイルパスの形式については、8.3.1 

add_fileを参照してください。 

パラメータ 

 <file>：設定されるファイルを指定します。複数指定できます(スペー

スで区切ります)。 

 [-lib <name>]：ファイルの library nameを設定します。このオプショ

ンは、VHDLファイルにのみ有効です。 

 [-h/--help]：ヘルプ情報を表示します。 

例 

set_file_prop -lib work top .vhd 

set_file_prop -lib work D:/gowin_project/top.vhd 

set_file_prop -lib work D:¥¥gowin_project¥¥top.vhd 

8.3.18 set_csr 

csrファイルを指定します。 
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構文 

set_csr [-h/--help ] <file> 

形式 

名称 説明 

<file> 指定されるcsrファイル 

[-h/--help] ヘルプ情報を表示します 

分類 

Project 

説明 

csrファイルを指定します。ファイルパスの形式については、8.3.1 

add_fileを参照してください。。 

パラメータ 

 <files>：csrファイルを指定します。 

 [-h/--help]：ヘルプ情報を表示します。。 

例 

set_csr a.csr 

set_csr D:/gowin_project/a.csr 

set_csr D:¥¥gowin_project¥¥a.csr 

 

8.3.19 set_option 

プロジェクトに関連する属性とプロセスのオプションを設定します。 

構文 

set_option [options] [-h/--help] 

形式 

名称 説明 

[options] 属性とプロセスのオプションを設定します。 

[-h/--help] ヘルプ情報を表示します 

分類 

Project 

説明 

         プロジェクトに関連する属性とプロセスのオプションを設定します。 

パラメータ 

 [options]：属性とプロセスのオプションを設定します。 
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 [-h/--help]：ヘルプ情報を表示します。 

Global属性の構成 

-output_base_name 

出力されるファイルの名前を指定します。 

構文 

-output_base_name <name> 

形式 

名称 説明 

<name> 出力されるファイルの名前を指定します。 

分類 

Project 

説明 

出力されるファイルの名前を指定します。このオプションはファイル

の base nameのみを指定します。出力ファイルのタイプに応じて適切な

拡張子が使用されます。例えば、-output_base_name abcの場合、

gowinsynthesisによって生成されるネットリスト・ファイルの名前は

abc.vgになります。 

パラメータ 

<name>：出力されるファイルの名前を指定します。 

例 

set_option -output_base_name abc 

-global_freq  

frequencyの値を指定します。 

構文 

-global_freq <default|value> 

形式 

名称 説明 

<default|value> frequencyの値を指定します 

分類 

Project 

説明 

frequencyの値を指定します。デフォルトでは、50MHz(LittleBeeファ

ミリー)または 100MHz(Aroraファミリー)です。 

パラメータ 
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<default|value>：frequencyの値。 

例 

set_option -global_freq 80 

合成属性の構成 

-synthesis_tool  

合成ツールを指定します。 

構文 

-synthesis_tool <tool> 

形式 

名称 説明 

<tool> 合成ツールを指定します 

分類 

Project 

説明 

合成ツール(GowinSynthesis)を指定します。 

パラメータ 

<tool>：合成ツール(GowinSynthesis)を指定します。 

例 

set_option -synthesis_tool GowinSynthesis 

-top_module 

Top Module/Entityを指定します。 

構文 

-top_module <name> 

形式 

名称 説明 

<name> top moduleを指定します 

分類 

Project 

説明 

top moduleを指定します。 

パラメータ 

<name>：top moduleを指定します。 

例 
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set_option -top_module test 

-include_path  

インクルードパスを指定します。 

構文 

-include_path <path or path list> 

形式 

名称 説明 

<path or path list> インクルードパスを指定します 

分類 

Project 

説明 

インクルードパスを指定します。複数のインクルードパスを指定する

場合は、セミコロンを使用してパスを区切り、中かっこ{}ですべてのパス

情報を含めます(例えば：-include_path {/path1;/path2;/path3})。相対パス

と絶対パスをサポートします。 

パラメータ 

<path or path list>：インクルードパスを指定します。 

例 

set_option -include_path D:/project 

-verilog_std 

Verilog言語のバージョンを指定します。 

構文 

-verilog_std<v1995|v2001|sysv2017> 

形式 

名称 説明 

<v1995|v2001|sysv2017> Verilog言語のバージョンを指定します 

分類 

Project 

説明 

Verilog言語：Verilog 95/Verilog 2001/System Verilog 2017。デフォル

トは Verilog 2001です。 

パラメータ 

<v1995|v2001|sysv2017>：Verilog言語のバージョンを指定します。 

例 
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set_option -verilog_std v1995 

-vhdl_std  

VHDL言語のバージョンを指定します。 

構文 

-vhdl_std <vhd1993|vhd2008|vhd2019> 

形式 

名称 説明 

< vhd1993|vhd2008|vhd2019> VHDL言語のバージョンを指定します 

分類 

Project 

説明 

VHDL言語のバージョンを指定します：VHDL 1993/VHDL 

2008/VHDL 2019。デフォルトは VHDL1993です。 

パラメータ 

<vhd1993|vhd2008|vhd2019>：VHDL言語のバージョンを指定しま

す。 

例 

set_option -vhdl_std vhd2008 

-print_all_synthesis_warning <0|1> 

すべての合成警告情報を出力するかどうかを指定します。デフォルト

は 0です。 

構文 

-print_all_synthesis_warning <0|1> 

形式 

名称 説明 

<0|1> 0：すべての警告情報を出力しません。 

1：すべての警告情報を出力します。 

分類 

Project 

説明 

すべての合成警告情報を出力するかどうかを指定します。デフォルト

は 0です。 

パラメータ 

<0|1>：すべての合成警告情報を出力するかどうかを指定します。 
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例 

set_option -print_all_synthesis_warning 1 

-disable_io_insertion  

I/O挿入を有効または無効にします。 

構文 

-disable_io_insertion <0|1> 

形式 

名称 説明 

<0|1> 0：I/O挿入を有効にします。 

1：I/O挿入を無効にします。 

分類 

Project 

説明 

I/O挿入を有効または無効にします。デフォルトは 0です。 

パラメータ 

<0|1>：I/O挿入を有効または無効にします。 

例 

set_option -disable_io_insertion 1 

-looplimit <value>  

RTL内のデフォルトのコンパイラのループ制限値。 

構文 

-looplimit <value> 

形式 

名称 説明 

<value> looplimitの値 

分類 

Project 

説明 

RTLのデフォルトのコンパイラのループ制限値で、デフォルト値は

2000です。 

パラメータ 

<value>：RTL内のデフォルトのコンパイラのループ制限値。 

例 
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set_option -looplimit 1000 

-maxfan <value>  

ファンアウト値を設定します。 

構文 

-maxfan <value> 

形式 

名称 説明 

<value> maxfanの値 

分類 

Project 

説明 

入力ポート、netまたはレジスタ出力ポートのファンアウト値を設定

します。デフォルトは 10000です。 

パラメータ 

<value>：入力ポート、net、またはレジスタの出力ポートのファンア

ウト値。 

例 

set_option -maxfan 5000 

-rw_check_on_ram   

RAMの周囲にバイパスロジックを挿入します。 

構文 

-rw_check_on_ram <0|1> 

形式 

名称 説明 

<0|1> 0：有効にしません。 

1：有効にします。 

分類 

Project 

説明 

RAMに読み出しまたは書き込みの競合がある場合、このオプション

を有効にすると、RAMの周りに、シミュレーションの不一致を防ぐため

のバイパスロジックが挿入されます。デフォルトでは 0です。 

パラメータ 

<0|1>：RAMの周囲にバイパスロジックを挿入することを有効または

無効にします。 
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例 

set_option -rw_check_on_ram 1 

Place & Route属性の構成 

-vccx  

VCCXの値を指定します。 

構文 

-vccx <value> 

形式 

名称 説明 

<value> VCCXの値を指定します。 

分類 

Project 

説明 

VCCXの値を指定します。 

パラメータ 

<value>：VCCXの値を指定します。 

例 

set_option -vccx 3.3 

-vcc  

構文 

-vcc <value> 

形式 

名称 説明 

<value> VCCの値を指定します。 

分類 

Project 

説明 

VCCの値を指定します。 

パラメータ 

<value>：VCCの値を指定します。 

例 

set_option -vcc 3.3 

-gen_sdf  
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SDFファイルを生成するかを指定します。 

構文 

-gen_sdf <0|1> 

形式 

名称 説明 

<0|1> 0：SDFファイルを生成しません。 

1：SDFファイルを生成します。 

分類 

Project 

説明 

Place＆Routeが SDFファイルを生成するかどうかを指定します。デ

フォルトは 0です。 

パラメータ 

<0|1>：SDFファイルを生成するかを指定します。 

例 

set_option -gen_sdf 1 

-gen_io_cst   

*.io.cstという名前のポートの物理制約ファイルを生成するかどうかを

指定します。 

構文 

-gen_io_cst <0|1> 

形式 

名称 説明 

<0|1> 0：*.io.cstファイルを生成しません。 

1：*.io.cstファイルを生成します。 

分類 

Project 

説明 

Place & Routeが*.io.cstという名前のポートの物理制約ファイルを生

成するかどうかを指定します。デフォルトは 0です。 

パラメータ 

<0|1>：ポートの物理制約ファイルを生成するかどうかを指定しま

す。 

例 
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set_option -gen_io_cst 1 

-gen_ibis   

*.ibsという名前の入出力バッファ情報指定ファイルを生成するかどう

かを指定します。 

構文 

-gen_ibis <0|1> 

形式 

名称 説明 

<0|1> 0：*.ibsファイルを生成しません。 

1：*.ibsファイルを生成します。 

分類 

Project 

説明 

Place＆Routeが*.ibsという名前の入出力バッファ情報指定ファイル

を生成するかどうかを指定します。デフォルトは 0です。 

パラメータ 

<0|1>：入出力バッファ情報指定ファイルを生成するかどうかを指定

します。 

例 

set_option -gen_ibis 1 

-gen_posp    

配置ファイルを生成するかどうかを指定します。 

構文 

-gen_posp <0|1> 

形式 

名称 説明 

<0|1> 0：*.pospファイルを生成しません。 

1：*.pospファイルを生成します。 

分類 

Project 

説明 

Place＆Routeが*.pospという名前の配置ファイルを生成するかどう

かを指定します。このファイルには、BSRAMの配置情報のみが含まれま

す。デフォルトは 0です。 

パラメータ 
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<0|1>：配置ファイルを生成するかどうかを指定します。 

例 

set_option -gen_posp 1 

-gen_text_timing_rpt  

テキスト形式のタイミングレポートを生成します。 

構文 

-gen_text_timing_rpt <0|1> 

形式 

名称 説明 

<0|1> 0：*.trファイルを生成しません。 

1：*.trファイルを生成します。 

分類 

Project 

説明 

Place＆Routeが*.trという名前のテキスト形式のタイミングレポート

を生成するかどうかを指定します。デフォルトは 0です。 

パラメータ 

<0|1>：テキスト形式のタイミングレポートを生成するかどうかを指

定します。 

例 

set_option -gen_text_timing_rpt 1 

-gen_verilog_sim_netlist  

Verilogタイミングシミュレーション・モデル・ファイルを生成する

かどうかを指定します。 

構文 

-gen_verilog_sim_netlist <0|1> 

形式 

名称 説明 

<0|1> 0：*.voファイルを生成しません。 

1：*.voファイルを生成します。 

分類 

Project 

説明 

Place＆Routeが*.voという名前の Verilogタイミングシミュレーショ
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ン・モデル・ファイルを生成するかどうかを指定します。デフォルトは 0

です。 

パラメータ 

<0|1>：Verilogタイミングシミュレーション・モデル・ファイルを生

成するかどうかを指定します。 

例 

set_option -gen_verilog_sim_netlist 1 

-gen_vhdl_sim_netlist   

VHDLタイミングシミュレーション・モデル・ファイルを生成するか

どうかを指定します。 

構文 

-gen_vhdl_sim_netlist <0|1> 

形式 

名称 説明 

<0|1> 0：*.vhoファイルを生成しません。 

1：*.vhoファイルを生成します。 

分類 

Project 

説明 

Place＆Routeが*.vhoという名前の VHDLタイミングシミュレーショ

ン・モデル・ファイルを生成するかどうかを指定します。デフォルトは 0

です。 

パラメータ 

<0|1>：VHDLタイミングシミュレーション・モデル・ファイルを生

成するかどうかを指定します。 

例 

set_option -gen_vhdl_sim_netlist 1 

-show_init_in_vo  

タイミングシシミュレーション・モデル・ファイルのインスタンスに

デフォルトの初期値を追加します。 

構文 

-show_init_in_vo <0|1> 

形式 

名称 説明 

<0|1> 0：タイミングシミュレーション・モデル・ファ
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イルのインスタンスにデフォルトの初期値を追加

しません。 

1：タイミングシシミュレーション・モデル・フ

ァイルのインスタンスにデフォルトの初期値を追

加します。 

分類 

Project 

説明 

配置配線後のタイミングシミュレーション・モデル・ファイルのイン

スタンスにデフォルトの初期値を追加するかどうかを指定します。デフォ

ルトは 0です。 

パラメータ 

<0|1>：配置配線後のタイミングシミュレーション・モデル・ファイ

ルのインスタンスにデフォルトの初期値を追加するかどうかを指定しま

す。 

例 

set_option -show_init_in_vo 1 

-show_all_warn  

すべての警告情報を出力するかどうかを指定します。 

構文 

-show_all_warn<0|1> 

形式 

名称 説明 

<0|1> 0：配置配線中のすべての警告情報を出力しません。 

1：配置配線中のすべての警告情報を出力します。 

分類 

Project 

説明 

配置配線中にすべての警告情報を出力するかどうかを指定します。デ

フォルトは 0です。 

パラメータ 

<0|1>：配置配線中にすべての警告情報を出力するかどうかを指定し

ます。 

例 

set_option -show_all_warn 1 

-timing_driven 
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タイミングドリブン配置配線を実行するかどうかを指定します。 

構文 

-timing_driven <0|1> 

形式 

名称 説明 

<0|1> 0：タイミングドリブン配置配線を実行しません。 

1：タイミングドリブン配置配線を実行します。 

分類 

Project 

説明 

タイミングドリブン配置配線を実行するかどうかを指定します。デフ

ォルトは 1です。 

パラメータ 

<0|1>：タイミングドリブン配置配線を実行するかどうかを指定しま

す。 

例 

set_option -timing_driven 1 

-cst_warn_to_error  

物理制約の警告をエラーに昇格させます。 

構文 

-cst_warn_to_error <0|1> 

形式 

名称 説明 

<0|1> 0：物理制約の警告をエラーに昇格させます。 

1：物理制約の警告をエラーに昇格させません。 

分類 

Project 

説明 

配置配線中の物理制約の警告をエラーに昇格させるかどうかを指定し

ます。デフォルトは 1です。 

パラメータ 

<0|1>：配置配線中の物理制約の警告をエラーに昇格させるかどうか

を指定します。 

例 
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set_option -cst_warn_to_error 1 

-rpt_auto_place_io_info  

1：自動配置の IO位置情報を報告します。 

構文 

-rpt_auto_place_io_info <0|1> 

形式 

名称 説明 

<0|1> 0：自動配置のIO位置情報を報告しません。 

1：自動配置のIO位置情報を報告します。 

分類 

Project 

説明 

配置配線の実行中に自動配置の IO位置情報を報告するかどうかを指

定します。デフォルトは 0です。 

パラメータ 

<0|1>：自動配置の IO位置情報を報告するかどうかを指定します。 

例 

set_option -cst_warn_to_error 1 

-place_option  

配置アルゴリズムオプション。 

構文 

-place_option <0|1|2|3|4> 

形式 

名称 説明 

<0|1|2|3|4> 0：デフォルトの配置アルゴリズムを使用しま

す。  

1：配置アルゴリズム 1を使用します。 

2：配置アルゴリズム 2を使用します。  

3：配置アルゴリズム 3を使用します。 

4：配置アルゴリズム 4を使用します。 

分類 

Project 

説明 

配置アルゴリズムオプション。デフォルトは 0です。 

パラメータ 
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<0|1|2|3|4>：配置アルゴリズムオプション。 

例 

set_option -place_option 1 

-route_option  

配線アルゴリズムオプション。 

構文 

-route_option <0|1|2> 

形式 

名称 説明 

<0|1|2> 0：デフォルトの配線アルゴリズムを使用しま

す。  

1：配線アルゴリズム1を使用します。  

2：配線アルゴリズム2を使用します。 

分類 

Project 

説明 

配線アルゴリズムオプション。デフォルトは 0です。 

パラメータ 

<0|1|2>：配線アルゴリズムオプション。 

例 

set_option -route_option 1 

-ireg_in_iob   

入力バッファに接続されるレジスタを IOBに配置します。 

構文 

-ireg_in_iob <0|1> 

形式 

名称 説明 

<0|1> 0：入力バッファに接続されるレジスタをIOBに配

置しません。 

1：入力バッファに接続されるレジスタをIOBに配

置します。 

分類 

Project 

説明 

このオプションを有効にすると、入力バッファに接続されるレジスタ
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は IOBに配置されます。デフォルトは 1です。 

パラメータ 

<0|1>：入力バッファに接続されるレジスタを IOBに配置するかどう

かを指定します。 

例 

set_option -ireg_in_iob 1 

-oreg_in_iob   

出力/トライステートバッファに接続されるレジスタを IOBに配置し

ます。 

構文 

-oreg_in_iob <0|1> 

形式 

名称 説明 

<0|1> 0：出力/トライステートバッファに接続されるレ

ジスタをIOBに配置しません。 

1：出力/トライステートバッファに接続されるレ

ジスタをIOBに配置します。 

分類 

Project 

説明 

このオプションを有効にすると、出力/トライステートバッファに接続

されるレジスタは IOBに配置されます。デフォルトは 1です。 

パラメータ 

<0|1>：出力/トライステートバッファに接続されるレジスタを IOBに

配置するかどうかを指定します。 

例 

set_option -oreg_in_iob 1 

-ioreg_in_iob   

双方向バッファに接続されるレジスタを IOBに配置します。 

構文 

-ioreg_in_iob <0|1> 

形式 

名称 説明 

<0|1> 0：双方向バッファに接続されるレジスタをIOBに配置

しません。 

1：双方向バッファに接続されるレジスタをIOBに配置
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します。 

分類 

Project 

説明 

このオプションを有効にすると、双方向バッファに接続されるレジス

タは IOBに配置されます。デフォルトは 1です。 

パラメータ 

<0|1>：双方向バッファに接続されるレジスタを IOBに配置するかど

うかを指定します。 

例 

set_option -ioreg_in_iob 1 

-replicate_resources   

高ファンアウトのリソースを複製してファンアウトを低減し、タイミ

ングの結果を改善します。 

構文 

-replicate_resources <0|1> 

形式 

名称 説明 

<0|1> 0：高ファンアウトのリソースを複製しません。 

1：高ファンアウトのリソースを複製してファンアウト

を低減します。 

分類 

Project 

説明 

このオプションを有効にすると、高ファンアウトのリソースが複製さ

れてファンアウトが低減され、タイミングの結果が改善されます。デフォ

ルトは 0です。 

パラメータ 

<0|1>：高ファンアウトのリソースを複製してファンアウトを低減す

るかどうかを指定します。 

例 

set_option -replicate_resources 1 

-clock_route_order   

クロックプリミティブにより生成されたクロックライン以外のクロッ

クラインの配線割り当て順を指定します。 
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構文 

-clock_route_order <0|1> 

形式 

名称 説明 

<0|1> 0：netのファンアウト数の多い順で割り当てま

す。 

1：周波数の高い順で割り当てます。 

分類 

Project 

説明 

クロックプリミティブにより生成されたクロックライン以外のクロッ

クラインの配線割り当て順を指定します。0と 1の 2つのオプションがあ

り、デフォルトは 0です。 

パラメータ 

<0|1>：クロックプリミティブにより生成されたクロックライン以外

のクロックラインの配線割り当て順を指定します。 

例 

set_option -clock_route_order 1 

-route_maxfan   

配線のファンアウトの最大数を設定します。 

構文 

-route_maxfan <value> 

形式 

名称 説明 

< value> 配線のファンアウトの最大数を設定します。 

分類 

Project 

説明 

配線のファンアウトの最大数を設定します。値は 0より大きく 100以

下の整数である必要があります。デバイスが GW1NZ-1/GW1N-

2/GW1NR-2/GW1N-1P5の場合、このオプションのデフォルト値は 10

で、他のデバイスの場合、デフォルト値は 23です。 

パラメータ 

<value>：配線のファンアウトの最大数を設定します。 

例 
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set_option -route_maxfan 60 

-correct_hold_violation  

配線によりタイミングの Hold違反を自動修正します。 

構文 

-correct_hold_violation <0|1> 

形式 

名称 説明 

<0|1> 0：配線によりタイミングのHold違反を自動修正しま

せん。 

1：配線によりタイミングのHold違反を自動修正しま

す。 

分類 

Project 

説明 

このオプションを有効にすると、配線によりタイミングの Hold違反

が自動修正されます。デフォルト値は 1です。 

パラメータ 

<0|1>：配線によりタイミングの Hold違反を自動修正するかどうかを

指定します。 

例 

set_option -correct_hold_violation 1 

-inc_place <0|auto|file>  

インクリメンタル配置。 

構文 

-inc_place <0|auto|file> 

形式 

名称 説明 

<0|auto|file > 0：インクリメンタル配置をオフにします。 

auto：自動的にインクリメンタル配置を実行します。 

file：*.pファイルを指定してインクリメンタル配置を

実行します。 

分類 

Project 

説明 

このオプションを有効にすると、インクリメンタル配置が使用されま

す。デフォルト値は 0です。 
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パラメータ 

<0|auto|file >：インクリメンタル配置を制御します。 

例 

set_option -inc_place auto 

 -inc_pnr <0|auto|file>  

インクリメンタル配置配線。 

構文 

-inc_pnr <0|auto|file> 

形式 

名称 説明 

<0|auto|file > 0：インクリメンタル配置配線をオフにします。 

auto：自動的にインクリメンタル配置配線を実行し

ます。 

file：*.pファイルを指定してインクリメンタル配置配

線を実行します。 

分類 

Project 

説明 

このオプションを有効にすると、インクリメンタル配置配線が使用さ

れます。デフォルト値は 0です。 

パラメータ 

<0|auto|file >：インクリメンタル配置配線を制御します。 

例 

set_option -inc_pnr auto 

注記： 

Place＆Routeのオプションの詳細については、このドキュメントのセクション

4.3.3の Place & Routeを参照してください。 

多重化ピンの属性の構成 

-use_jtag_as_gpio  

JTAGピンを GPIOとして多重化します。 

構文 

-use_jtag_as_gpio <0|1> 

形式 
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名称 説明 

<0|1> 0：JTAG専用ピンとして使用します。 

1：GPIOとして多重化します 

分類 

Project 

説明 

JTAGピンを GPIOとして多重化します。デフォルトは 0です。 

パラメータ 

<0|1>：JTAGピンを GPIOとして多重化するかどうかを指定します。 

例 

set_option -use_jtag_as_gpio 1 

-use_sspi_as_gpio  

SSPIピンを GPIOとして多重化します。 

構文 

-use_sspi_as_gpio <0|1> 

形式 

名称 説明 

<0|1> 0：SSPI専用ピンとして使用します。 

1：GPIOとして多重化します 

分類 

Project 

説明 

SSPIピンを GPIOとして多重化します。デフォルトは 0です。 

パラメータ 

<0|1>：SSPIピンを GPIOとして多重化するかどうかを指定します。 

例 

set_option -use_sspi _as_gpio 1 

-use_mspi_as_gpio  

MSPIピンを GPIOとして多重化します。 

構文 

-use_mspi_as_gpio <0|1> 

形式 
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名称 説明 

<0|1> 0：MSPI専用ピンとして使用します。 

1：GPIOとして多重化します 

分類 

Project 

説明 

MSPIピンを GPIOとして多重化します。デフォルトは 0です。 

パラメータ 

<0|1>：MSPIピンを GPIOとして多重化するかどうかを指定します。 

例 

set_option -use_mspi _as_gpio 1 

-use_ready_as_gpio  

READYピンを GPIOとして多重化します。 

構文 

-use_ready_as_gpio <0|1> 

形式 

名称 説明 

<0|1> 0：READY専用ピンとして使用します。 

1：GPIOとして多重化します 

分類 

Project 

説明 

READYピンを GPIOとして多重化します。デフォルトは 0です。 

パラメータ 

<0|1>：READYピンを GPIOとして多重化するかどうかを指定しま

す。 

例 

set_option -use_ready_as_gpio 1 

-use_done_as_gpio  

DONEピンを GPIOとして多重化します。 

構文 

-use_done_as_gpio <0|1> 

形式 
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名称 説明 

<0|1> 0：DONE専用ピンとして使用します。 

1：GPIOとして多重化します 

分類 

Project 

説明 

DONEピンを GPIOとして多重化します。デフォルトは 0です。 

パラメータ 

<0|1>：DONEピンを GPIOとして多重化するかどうかを指定しま

す。 

例 

set_option -use_ done_as_gpio 1 

-use_reconfign_as_gpio  

RECONFIG_Nピンを GPIOとして多重化します。 

構文 

-use_ reconfign_as_gpio <0|1> 

形式 

名称 説明 

<0|1> 0：RECONFIG_N専用ピンとして使用します。 

1：GPIOとして多重化します 

分類 

Project 

説明 

RECONFIG_Nピンを GPIOとして多重化します。デフォルトは 0で

す。 

パラメータ 

<0|1>：RECONFIG_Nピンを GPIOとして多重化するかどうかを指

定します。 

例 

set_option -use_reconfign_as_gpio 1 

-use_i2c_as_gpio  

I2Cピンを GPIOとして多重化します。 

構文 

-use_i2c_as_gpio <0|1> 
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形式 

名称 説明 

<0|1> 0：I2C専用ピンとして使用します。 

1：GPIOとして多重化します 

分類 

Project 

説明 

I2Cピンを GPIOとして多重化します。デフォルトは 0です。 

パラメータ 

<0|1>：I2Cピンを GPIOとして多重化するかどうかを指定します。 

例 

set_option -use_i2c_as_gpio 1 

BitStreamの属性の構成 

-bit_format   

生成されるビットストリームファイルのコンテンツの形式を指定しま

す。 

構文 

-bit_format <txt|bin> 

形式 

名称 説明 

<txt|bin> ビットストリームファイルのコンテンツの形式。 

分類 

Project 

説明 

生成されるビットストリームファイルのコンテンツの形式を指定しま

す。デフォルトは binです。 

パラメータ 

<txt|bin>：生成されるビットストリームファイルのコンテンツの形式

を指定します。 

例 

set_option -bit_format txt 

-bit_crc_check  

巡回冗長検査。 

構文 
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-bit_crc_check <0|1> 

形式 

名称 説明 

<0|1> 0：巡回冗長検査を有効にしません。 

1：巡回冗長検査を有効にします。 

分類 

Project 

説明 

ビットストリームファイルの巡回冗長検査を有効にするかどうかを指

定します。デフォルトは 1です。 

パラメータ 

<0|1>：ビットストリームファイルの巡回冗長検査を有効にするかど

うかを指定します。 

例 

set_option -bit_crc_check 1 

-bit_compress   

ビットストリームファイルを圧縮します。 

構文 

-bit_compress <0|1> 

形式 

名称 説明 

<0|1> 0：ビットストリームファイルを圧縮しません。 

1：ビットストリームファイルを圧縮します。 

分類 

Project 

説明 

生成されるビットストリームファイルを圧縮します。デフォルトは 1

です。 

パラメータ 

<0|1>：ビットストリームファイルを圧縮するかどうかを指定しま

す。 

例 

set_option -bit_compress 1 

-bit_encrypt  
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ビットストリームファイルを暗号化します。 

構文 

-bit_encrypt <0|1> 

形式 

名称 説明 

<0|1> 0：暗号化しません。 

1：暗号化します。 

分類 

Project 

説明 

ビットストリームファイルを暗号化します(Aroraファミリーのみをサ

ポート)。デフォルトは 0です。 

パラメータ 

<0|1>：ビットストリームファイルを暗号化するかどうかを指定しま

す。 

例 

set_option -bit_encrypt 1 

-bit_encrypt_key    

暗号化キーをカスタマイズします。 

構文 

-bit_encrypt_key <key> 

形式 

名称 説明 

<key> 暗号化キー。 

分類 

Project 

説明 

「-bit_encrypt」と併用することによりユーザーは暗号化キーをカスタ

マイズできます。デフォルトは全部 0です。 

パラメータ 

<key>：暗号化キー。 

例 

set_option -bit_encrypt_key 00000000000000000000000000001101  

-bit_security   
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セキュリティ・ビットを有効にするかどうかを指定します。 

構文 

-bit_security <0|1> 

形式 

名称 説明 

<0|1> 0：セキュリティ・ビットを有効にしません。 

1：セキュリティ・ビットを有効にします。 

分類 

Project 

説明 

セキュリティ・ビットを有効にするかどうかを指定します。デフォル

トは 1です。 

パラメータ 

<0|1>：セキュリティ・ビットを有効にするかどうかを指定します。 

例 

set_option -bit_security 1 

-bit_incl_bsram_init   

BSRAMの初期値をビットストリームファイルに書き込みます。 

構文 

-bit_incl_bsram_init <0|1> 

形式 

名称 説明 

<0|1> 0：BSRAMの初期値をビットストリームファイルに書

き込みません。 

1：BSRAMの初期値をビットストリームファイルに書

き込みます。 

分類 

Project 

説明 

BSRAMの初期値をビットストリームファイルに書き込みます。デフ

ォルトは 1です。GW1N(X)シリーズおよび GW2A(X)シリーズの場合、1

にセットすると、すべての位置の BSRAMの初期値がビットストリーム

ファイルに書き込まれます(占有されていない BSRAM位置の初期値は 0

として取り扱われます)。GW5A(N)(S)(R)(T)デバイスの場合、1にセット

すると、占有された BSRAMの所在列にあるすべての BSRAMの初期値

がビットストリームファイルに書き込まれます(この列の占有されていな
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い BSRAM位置の初期値は 0として取り扱われます)。 

パラメータ 

<0|1>：BSRAMの初期値をビットストリームファイルに書き込むか

どうかを指定します。 

例 

set_option -bit_incl_bsram_init 1 

-bg_programming   

バックグラウンド・アップグレード機能。 

構文 

-bg_programming <off | jtag | i2c | goconfig | userlogic | 
i2c_jtag_sspi_qsspi | jtag_sspi_qsspi> 

形式 

名称 説明 

<off|jtag|i2c|goconfig|userlogic| 
i2c_jtag_sspi_qsspi|jtag_sspi_qsspi> 

off：バックグラウンド・アップグレー

ド機能を有効にしません。 

jtag：JTAGモードでバックグラウン

ド・アップグレードを実行します。 

i2c：I2Cモードでバックグラウンド・

アップグレードを実行します。 

goconfig：goConfig IPでバックグラウ

ンド・アップグレードを実行します。 

userlogic：FPGAの内部論理でバック

グラウンド・アップグレードを実行し

ます。 

i2c_jtag_sspi_qsspi：

I2C/JTAG/SSPI/QSSPIモードでバック

グラウンド・アップグレードを実行し

ます。 

jtag_sspi_qsspi：JTAG/SSPI/QSSPIモ

ードでバックグラウンド・アップグレ

ードを実行します。 

分類 

Project 

説明 

FPGAの動作を中断しないまま FPGAをプログラムするバックグラウ

ンド・アップグレード機能です。デフォルトは offです。 

パラメータ 

< off | jtag | i2c | goconfig | userlogic | i2c_jtag_sspi_qsspi | 

jtag_sspi_qsspi>：バックグラウンド・アップグレードの方法。 
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例 

set_option -bg_programming userlogic 

-hotboot  

ホットブートモード。 

構文 

-hotboot <0|1> 

形式 

名称 説明 

<0|1> 0：ホットブートモードを使用しません。 

1：ホットブートモードを使用します。 

分類 

Project 

説明 

ホットブートモードを使用するかどうかを指定します。デフォルトは

0です。 

パラメータ 

<0|1>：ホットブートモードを使用するかどうかを指定します。 

例 

set_option -hotboot 1 

-i2c_slave_addr  

I2Cデバイスのアドレスを設定します。 

構文 

-i2c_slave_addr <value> 

形式 

名称 説明 

<value> I2Cデバイスのアドレスを設定します。 

分類 

Project 

説明 

I2Cデバイスのアドレスを設定します。範囲は 00~7F。デフォルトは

00です。 

パラメータ 

<value>：I2Cデバイスのアドレス。 

例 
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set_option -i2c_slave_addr 2F 

-secure_mode   

セキュアモードを有効にします。 

構文 

-secure_mode <0|1> 

形式 

名称 説明 

<0|1> 0：セキュアモードを有効にしません。 

1：セキュアモードを有効にします。 

分類 

Project 

説明 

セキュアモードを有効にすると、JTAGピンは GPIOとなり、デバイ

スは 1回しかプログラムできなくなります。デフォルトは 0です。 

パラメータ 

<0|1>：セキュアモードを有効にするかどうかを指定します。 

例 

set_option -secure_mode 1 

-loading_rate   

AutoBootコンフィギュレーション・モードおよび MSPIコンフィギ

ュレーション・モードでの、Flashから SRAMへのビットストリームデ

ータの読み込み速度。 

構文 

-loading_rate <value> 

形式 

名称 説明 

<value> AutoBootコンフィギュレーション・モードおよびMSPI

コンフィギュレーション・モードでの、Flashから

SRAMへのビットストリームデータの読み込み速度。 

分類 

Project 

説明 

AutoBootコンフィギュレーション・モードおよび MSPIコンフィギ

ュレーション・モードでの、Flashから SRAMへのビットストリームデ

ータの読み込み速度。デフォルトは 2.500MHzです。 
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パラメータ 

<value>：Flashから SRAMへのビットストリームデータの読み込み

速度。 

例 

set_option -loading_rate 21.000MHz 

-seu_handler   

シングル・イベント・アップセット・ハンドラを有効にするか選択し

ます。 

構文 

-seu_handler <0|1> 

形式 

名称 説明 

<0|1> 0：シングル・イベント・アップセット・ハンドラを有効

にしません。 

1：シングル・イベント・アップセット・ハンドラを有効

にします。 

分類 

Project 

説明 

シングル・イベント・アップセット・ハンドラを有効にするか選択し

ます。デフォルトは 0です。 

パラメータ 

<0|1>：シングル・イベント・アップセット・ハンドラを有効にする

か選択します。 

例 

set_option -seu_handler 1 

-seu_handler_mode   

SEU Handlerを開始または停止するモードを選択します。 

構文 

-seu_handler_mode <auto|userlogic> 

形式 

名称 説明 

<0|1> auto：チップのウェイクアップ後、シングル・イベン

ト・アップセット・ハンドラが自動的に有効にされま

す。 

userlogic：ロジックを使用してシングル・イベント・ア
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ップセット・ハンドラを有効または無効にします。 

分類 

Project 

説明 

SEU Handlerを開始または停止するモードを選択します。デフォルト

は autoです。 

パラメータ 

<auto|userlogic>：SEU Handlerを開始または停止するモードを選択

します。 

例 

set_option -seu_handler_mode userlogic 

-seu_handler_checksum   

シングル・イベント・アップセット・ハンドリング、検出、計算、比

較を有効にするか選択します。 

構文 

-seu_handler_checksum <0|1> 

形式 

名称 説明 

<0|1> 0：シングル・イベント・アップセット・ハンドリン

グ、検出、計算、比較を有効にしません。 

1：シングル・イベント・アップセット・ハンドリン

グ、検出、計算、比較を有効にします。 

分類 

Project 

説明 

シングル・イベント・アップセット・ハンドリング、検出、計算、比

較を有効にするか選択します。デフォルトは 0です。 

パラメータ 

<0|1>：シングル・イベント・アップセット・ハンドリング、検出、

計算、比較を有効にするか選択します。 

例 

set_option -seu_handler_checksum 1 

-error_detection   

エラー検出のみを有効にします。 

構文 
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-error_detection <0|1> 

形式 

名称 説明 

<0|1> 0：エラー検出を有効にしません。 

1：エラー検出のみを有効にします。 

分類 

Project 

説明 

エラー検出のみを有効にします。デフォルトは 0です。 

パラメータ 

<0|1>：エラー検出のみを有効にするかどうかを指定します。 

例 

set_option -error_detection 1 

-error_detection_correction   

エラーの検出と訂正を有効にします。 

構文 

-error_detection_correction <0|1> 

形式 

名称 説明 

<0|1> 0：エラーの検出と訂正を有効にしません。 

1：エラーの検出と訂正を有効にします。 

分類 

Project 

説明 

エラーの検出と訂正を有効にします。デフォルトは 0です。 

パラメータ 

<0|1>：エラーの検出と訂正を有効にするかどうかを指定します。 

例 

set_option -error_detection_correction 1 

-stop_seu_handler   

SEU Handlerを停止します。 

構文 

-stop_seu_handler <0|1> 
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形式 

名称 説明 

<0|1> 0：訂正不可能なECCエラーまたはCRCチェックサム・ミ

スマッチ・エラーが検出された場合、SEU Handlerを停止

しません。 

1：訂正不可能なECCエラーまたはCRCチェックサム・ミ

スマッチ・エラーが検出された場合、SEU Handlerを停止

します。 

分類 

Project 

説明 

訂正不可能な ECCエラーまたは CRCチェックサム・ミスマッチ・エ

ラーが検出された場合、SEU Handlerを停止します。デフォルトは 0で

す。 

パラメータ 

<0|1>：SEU Handlerを停止するかどうかを指定します。 

例 

set_option -stop_seu_handler 1 

-osc_div   

拡張コントロール・レジスタの分周値を設定します。 

構文 

-osc_div <4|8|16|32> 

形式 

名称 説明 

<4|8|16|32> 4：拡張コントロール・レジスタの分周値を4に設定し

ます。 

8：拡張コントロール・レジスタの分周値を8に設定し

ます。 

16：拡張コントロール・レジスタの分周値を16に設定

します。 

32：拡張コントロール・レジスタの分周値を32に設定

します。 

分類 

Project 

説明 

拡張コントロール・レジスタの分周値を設定します。デフォルトは 8

です。 
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パラメータ 

<4|8|16|32>：拡張コントロール・レジスタの分周値。 

例 

set_option -osc_div 8 

-error_injection   

エラー挿入を有効にします。 

構文 

-error_injection <0|1> 

形式 

名称 説明 

<0|1> 0：エラー挿入を有効にしません。 

1：エラー挿入を有効にします。 

分類 

Project 

説明 

エラー挿入を有効にします。デフォルトは 0です。 

パラメータ 

<0|1>：エラー挿入を有効にするかどうかを指定します。 

例 

set_option -error_injection 1 

-ext_cclk   

外部マスター・コンフィギュレーション・クロックを有効にします。 

構文 

-ext_cclk <0|1> 

形式 

名称 説明 

<0|1> 0：外部マスター・コンフィギュレーション・クロックを

有効にしません。 

1：外部マスター・コンフィギュレーション・クロックを

有効にします。 

分類 

Project 

説明 

外部マスター・コンフィギュレーション・クロックを有効にします。
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デフォルトは 0です。 

パラメータ 

<0|1>：外部マスター・コンフィギュレーション・クロックを有効に

するかどうかを指定します。 

例 

set_option -ext_cclk 1 

-ext_cclk_div   

分周器のパラメータを設定します。 

構文 

-ext_cclk_div <value> 

形式 

名称 説明 

<value> 分周器のパラメータ。 

分類 

Project 

説明 

分周器のパラメータを設定します。 

パラメータ 

< value>：分周器のパラメータを設定します。 

例 

set_option -ext_cclk_div 4 

-multi_boot 

Multi Bootを有効にするかどうかを指定します。 

構文 

-multi_boot <0|1> 

形式 

名称 説明 

<0|1> 0：Multi Bootを有効にしません。 

1：Multi Bootを有効にします。 

分類 

Project 

説明 

Multi Bootを有効にするかどうかを指定します。デフォルトは 0で

す。 
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パラメータ 

<0|1>：Multi Bootを有効にするかどうかを指定します。 

例 

set_option -multi_boot 1 

-multiboot_address_width 

SPI Flashアドレスの幅を構成します。 

構文 

-multiboot_address_width<24|32> 

形式 

名称 説明 

<24|32> 24：SPI Flashアドレスの幅を24に構成します。 

32：SPI Flashアドレスの幅を32に構成します。 

分類 

Project 

説明 

SPI Flashアドレスの幅を構成します。デフォルトは 24です。 

パラメータ 

<24|32>：SPI Flashアドレスの幅。 

例 

set_option -multiboot_address_width 32 

-multiboot_spi_flash_address  

SPI Flashアドレスを指定します。 

構文 

-multiboot_spi_flash_address <value> 

形式 

名称 説明 

<value> SPI Flashアドレス。 

分類 

Project 

説明 

SPI Flashアドレスを指定します。SPI Flashアドレスは、次の

multibootの際にビットストリームファイルが読み込まれる開始アドレス

で、デフォルトは 000000です。 
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パラメータ 

<value>：SPI Flashアドレス。 

例 

set_option -multiboot_spi_flash_address 000110 

-multiboot_mode  

SPI Flashのアクセスモードを構成します。 

構文 

-multiboot_mode <single | fast | dual | quad> 

形式 

名称 説明 

< single|fast|dual|quad > single：singleモードを使用します。 

fast：fastモードを使用します。 

dual：dualモードを使用します。 

quad：quadモードを使用します。 

分類 

Project 

説明 

SPI Flashのアクセスモードを構成します。デフォルトは singleで

す。 

パラメータ 

< single | fast | dual | quad >：SPI Flashのアクセスモード。 

例 

set_option -multiboot_mode single  

-mspi_jump 

MSPI JUMPを有効にするかどうかを指定します。 

構文 

-mspi_jump<0|1> 

形式 

名称 説明 

<0|1> 0：MSPI JUMPを有効にしません。 

1：MSPI JUMPを有効にします。 

分類 

Project 

説明 
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MSPI JUMPを有効にするかどうかを指定します。デフォルトは 0で

す。 

パラメータ 

<0|1>：MSPI JUMPを有効にするかどうかを指定します。 

例 

set_option -mspi_jump 1 

-merge_jumpbit 

MSPI JUMPビットストリームファイルを汎用ビットストリームファ

イルにマージします。 

構文 

-merge_jumpbit <0|1> 

形式 

名称 説明 

<0|1> 0：ビットストリームファイルをマージしませ

ん。 

1：ビットストリームファイルをマージします。 

分類 

Project 

説明 

MSPI JUMPビットストリームファイルを汎用ビットストリームファ

イルにマージするか選択します。デフォルトは 0です。 

パラメータ 

<0|1>：MSPI JUMPビットストリームファイルを汎用ビットストリー

ムファイルにマージするかどうかを指定します。 

例 

set_option -merge_jumpbit 1 

-mspijump_address_width 

SPI Flashアドレスの幅を構成します。 

構文 

-mspijump_address_width <24|32> 

形式 

名称 説明 

<24|32> 24：SPI Flashアドレスの幅を24に構成します。 

32：SPI Flashアドレスの幅を32に構成します。 

分類 
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Project 

説明 

SPI Flashアドレスの幅を構成します。デフォルトは 24です。 

パラメータ 

<24|32>：SPI Flashアドレスの幅。 

例 

set_option - mspijump_address_width 32 

-mspijump_spi_flash_address 

SPI Flashアドレスを指定します。 

構文 

-mspijump_spi_flash_address <value> 

形式 

名称 説明 

<value> SPI Flashアドレス。 

分類 

Project 

説明 

SPI Flashアドレスを指定します。デフォルトは 000000です。 

パラメータ 

<value>：SPI Flashアドレス。 

例 

set_option - mspijump_spi_flash_address 000110 

-mspijump_mode<single | fast | dual | quad> 

SPI Flashのアクセスモードを構成します。 

構文 

-mspijump_mode <single | fast | dual | quad> 

形式 

名称 説明 

< single|fast|dual|quad > single：singleモードを使用します。 

fast：fastモードを使用します。 

dual：dualモードを使用します。 

quad：quadモードを使用します。 

分類 

Project 
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説明 

SPI Flashのアクセスモードを構成します。デフォルトは singleで

す。 

パラメータ 

< single | fast | dual | quad >：SPI Flashのアクセスモード。 

例 

set_option -mspijump_mode single  

-program_done_bypass   

新しいビットストリームデータを転送します。 

構文 

-program_done_bypass <0|1> 

形式 

名称 説明 

<0|1> 0：この機能を有効にしません。 

1：この機能を有効にします。 

分類 

Project 

説明 

Done Final信号が有効になった場合、外部の Done信号を Lowのま

まにすることにより、ビットストリームがロードされた後に新しいビット

ストリームデータを転送できるようにします。デフォルトは 0です。 

パラメータ 

<0|1>：新しいビットストリームデータを転送する機能を有効にする

かどうかを指定します。 

例 

set_option -program_done_bypass 1 

-power_on_reset_monitor <0|1> 

パワーオンリセット。 

構文 

-power_on_reset_monitor <0|1> 

形式 

名称 説明 

<0|1> 0：パワーオンリセット機能を有効にしません。 

1：パワーオンリセット機能を有効にします。 



8 Tclコマンドの説明 8.3コマンドの説明 

 

SUG100-4.4.2J 149(157) 

 

分類 

Project 

説明 

パワーオンリセット機能の制御。デフォルトは 0です。 

パラメータ 

<0|1>：パワーオンリセット機能を有効にするかどうかを指定しま

す。 

例 

set_option -power_on_reset_monitor 1 

-turn_off_bg 

Bandgap機能。 

構文 

-turn_off_bg <0|1> 

形式 

名称 説明 

<0|1> 0：Bandgap機能を有効にします。 

1：Bandgap機能を有効にしません。 

分類 

Project 

説明 

Bandgap機能の制御。デフォルトは 0です。 

パラメータ 

<0|1>：Bandgap機能を有効にするかどうかを指定します。 

例 

set_option -turn_off_bg 1 

-wakeup_mode   

Wake Up Modeを有効にするかどうかを指定します。 

構文 

-wakeup_mode <0|1> 

形式 

名称 説明 

<0|1> 0：Wake Up Modeを有効にしません。 

1：Wake Up Modeを有効にします。 

分類 
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Project 

説明 

Wake Up Modeを有効にするかどうかを指定します。デフォルトは 0

です。 

パラメータ 

<0|1>：Wake Up Modeを有効にするかどうかを指定します。 

例 

set_option -wakeup_mode 1 

-user_code   

User Codeをカスタマイズします。 

構文 

-user_code <default|value> 

形式 

名称 説明 

<default|value> User Codeの値をカスタマイズします。 

分類 

Project 

説明 

User Codeをカスタマイズできます。デフォルトは

default(00000000)です。 

パラメータ 

<default|value>：User Codeをカスタマイズします。 

例 

set_option -user_code 00000010 

注記： 

BitStreamのオプションの詳細については、このドキュメントの 4.3.3セクションの

BitStreamを参照してください。 

Unused Pinの属性の構成 

-unused_pin 

未使用 GPIOの IO属性を設定します。 

構文 

-unused_pin <default|open_drain> 

形式 

名称 説明 
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<default|open_drain> default：未使用のGPIOを、弱いプルアップを持

つトライステート入力として構成します。 

open_drain：未使用のGPIOを出力として構成し

ます(OPEN DRAINはオン)。 

分類 

Project 

説明 

未使用 GPIOの IO属性を設定します。 

パラメータ 

<default|open_drain>：未使用 GPIOの IO属性を設定します。 

例 

set_option -unused_pin open_drain 

注記： 

Unused Pinのオプションの詳細については、このドキュメントの 4.3.3セクション

の Unused Pinを参照してください。 

8.3.20 set_property 

オブジェクトの属性を設定します。 

構文 

set_property [-dict <args>] <name> <value> <objects> 

形式 

名称 説明 

[-dict] 設定される属性ペア（name/value）のリスト 

<name> 設定される属性の名前。-dictを使用する場合は無効です 

<value> 設定される属性の値。-dictを使用する場合は無効です 

<objects> 設定される属性のオブジェクト 

分類 

IPFlow 

説明 

指定された IPオブジェクトのオプションとそれに対応するオプショ

ン値を設定します。 

パラメータ 

 [-dict]：複数のオプションとそれに対応するオプション値のペアを含

む辞書を指定します。ペアは(<name> <value>)で指定され、複数のペ

アはスペースで区切られます。辞書は中括弧{}で囲む必要がありま

す。 
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 <name>：設定されるオプションの名前を指定します。説明の形式は 

CONFIG.propertyです。ここで、propertyはオプション名を指しま

す。 

 <value>：設定されるオプションに対応するオプション値を指定しま

す。属性タイプに応じて値を決定する必要があります。オプション値

が文字列の場合、元の形式である必要があります。 

 <objects>：設定されるオプションの 1つまたは複数の IPオブジェク

トを指定します。1つのオブジェクトは[get_ips module_name]で指定

されます。複数のオブジェクトは、[get_ips module_name0 

module_name1 …] で指定されます。 

例 

-dictオプションを使用して現在のデザインで複数の属性を一度に指定

します： 

set_property -dict {CONFIG.Data_Width 16 CONFIG.Write_Depth 
1024 CONFIG.Read_Depth 1024} [get_ips FIFO_Top] 

（name, value, objects）を使用して現在のデザインで 1つの属性を指

定します。 

set_property CONFIG.Data_Width {16} [get_ips FIFO_Top] 

この例では、ダッシュ「-」またはスペースを含む属性値を設定する

方法を示します。 

set_property {CONFIG.Almost_Full_Type} {Full-Single Threshold 
Constant Parameter} [get_ips FIFO_Top] 

注記： 

場合によっては、オプション値にダッシュ「-」やスペースなどの特殊文字が含まれ

ることがあるため、オプション値が正しく解析されない可能性があります。この場

合、オプション値を中括弧{}で囲む必要があります。 

関連項目 

 list_property 

 report_property 

8.3.21 source 

Gowinソフトウェアの Tclコマンド編集ウィンドウで、またはコマン

ド・ライン・モードを開始した後、このコマンドを使用して Tclスクリプ

トを実行します。ファイルパスの形式については、8.3.1 add_fileを参照

してください。 

構文 

source <file> 

形式 

名称 説明 
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<file> 実行されるTclスクリプト。 

分類 

IPFlow，Project 

説明 

未使用 GPIOの IO属性を設定します。 

パラメータ 

<file>：実行される Tclスクリプトファイル。 

例 

source project.tcl 

source D:/gowin_project/project.tcl 

source D:¥¥gowin_project¥¥project.tcl 

8.3.22 write_ip_tcl 

Tclスクリプトをエクスポートします。このスクリプトは、指定され

た IPを再生成できます。 

構文 

write_ip_tcl [-ip_name <newModuleName>] [-multiple_files] [-force] 
[<tcl_filename>] <objects> 

形式 

名称 説明 

[-ip_name] IPのモジュール名 

[-multiple_files] IPオブジェクトごとに.tclファイルを作成します 

[-force] 既存のファイルを上書きします 

[<tcl_filename>] エクスポートされる tclファイル 

<objects> エクスポートされる tclファイルの IPオブジェクト 

分類 

IPFlow 

説明 

このコマンドは、指定された IPオブジェクトの Tclスクリプトファイ

ルをエクスポートします。ファイルパスの形式については、8.3.1 add_file

を参照してください。 

パラメータ 

 [<tcl_filename>]：生成される Tclスクリプトファイルの名前。指定し

ない場合は、現在のプロジェクト名が使用されます。 

 <objects>：Tclスクリプトが生成される 1つまたは複数の IPオブジェ

クトを指定します。1つのオブジェクトは[get_ips module_name]で指
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定されます。複数のオブジェクトは、[get_ips module_name0 

module_name1 …] で指定されます。 

 [-ip_name <newModuleName>]：生成された Tclスクリプト内の IPの 

module_nameを変更します。1つのオブジェクトのみを指定できま

す。 

 [-multiple_files]：指定されたすべての IPに対して Tclスクリプトファ

イルを生成します。スクリプト名は、対応する IPの module_nameに

基づいて命名されます。このオプションは、-ip_nameおよび

<tcl_filename>と相互に排他的です。 

 [-force]：同じ名前の既存の Tclファイルを上書きします。 

例 

この例では、IPオブジェクト FIFO_Topに対して FIFO_Top_newと

いう名前の Tclファイルが作成されます。 

write_ip_tcl -ip_name FIFO_Top_new [get_ips FIFO_Top] 

この例では、指定された IPモジュールごとに個別の Tclファイルが作

成されます。 

write_ip_tcl -multiple_files [get_ips FIFO_Top FIFO_Top_1] 

この例では、指定された複数の IPモジュールが 1つの Tclファイルに

書き込まれます。 

write_ip_tcl [get_ips FIFO_Top FIFO_Top_1] my_fifo.tcl 
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9 付録 

9.1 ファイルの説明 

Gowinソフトウェアは、プロジェクトに物理制約やタイミング制約

などのファイルを追加することをサポートしています。デザインの合成や

配置配線の際、様々な実行ファイルが生成されます。ここでは、Gowin

ソフトウェアがサポートしている様々なファイルタイプを表形式で紹介し

ます。 

表 9-1ソースファイル 

タイプ 定義 説明 

.gsc 合成の制約ファイル 
合成ツール GowinSynthesisのための制約

ファイル 

.ipc IP構成ファイル 

IP Core Generatorは、.ipcファイルを読

み込んで、その構成を変更して IPを再生

成することができます。 

.cst 物理制約ファイル 
設計に物理制約を追加するために使用され

ます。 

.sdc 
タイミング制約ファイ

ル 

設計にタイミング制約を追加するために使

用されます。 

.fi 
User Flashの初期化フ

ァイル 

プログラマでビットストリームをダウンロ

ードする際にロードできる User Flashの

初期化ファイルあり、User Flashを初期化

します。 

.rao 
RTLレベルの GAO構

成ファイル 

合成最適化前の RTL信号のキャプチャに

使用されます。 

.gao 
合成後の GAO構成フ

ァイル 

合成最適化後のネットリスト信号のキャプ

チャに使用されます。 

.gvio 
仮想入力出力の構成フ

ァイル 

内部 FPGA信号をリアルタイムで監視お

よび駆動するために使用されます。 

.gpa 
消費電力解析の構成フ

ァイル 

設計の消費電力の解析に使用されます。 
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タイプ 定義 説明 

.mi メモリ初期化ファイル 

メモリの初期化に使用されます。 この初

期化ファイルは、IP Core Generatorでメ

モリを生成する際に使用されます。 

.v Verilogソースファイル 
回路の構造と機能を記述した Verilog記述

ファイル 

.sv 
System Verilogソース

ファイル 

回路の構造と機能を記述した System 

Verilog記述ファイル 

.vhd VHDLソースファイル 
回路の構造と機能を記述した VHDL記述フ

ァイル 

 

表 9-2実行ファイル 

タイプ 定義 説明 

.vg 
合成後のネットリスト・

ファイル 

GowinSynthesisによる合

成後に生成されたネット

リスト・ファイル 

_syn.rpt.html 合成レポートファイル 

合成後のリソース使用量

やタイミング解析などの

情報を提供します。 

.fs BitStreamファイル 
プログラマによりダウン

ロードされます。 

.bin 
bin形式の BitStreamファ

イル 

プログラマによりダウン

ロードされます。 

.ekey キー・ファイル 

暗号化されたビットスト

リームファイルを

Programmerによるダウ

ンロードの際に復号化す

るために使用されます。 

.vo 

配置配線後の Verilog形式

のタイミングシミュレー

ション・モデルファイル 

タイミングシミュレーシ

ョンのためのフラット化

構造の Verilogモデルファ

イル 

.vho 

配置配線後の VHDL形式

のタイミングシミュレー

ション・モデルファイル 

タイミングシミュレーシ

ョンのためのフラット化

構造の VHDLモデルファ

イル 

.sdf 標準の遅延形式ファイル 

配置配線後のネットリス

ト・タイミングシミュレ

ーションに使用されま

す。 

.ibs 
入出力バッファ情報指定

ファイル 

– 

.tr 
テキスト形式のタイミン

グレポート 

– 
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タイプ 定義 説明 

.rpt.txt 
テキスト形式の配置配線

レポート 

– 

.rpt.html 
html形式の配置配線レポ

ート 

– 

.tr.html 
html形式のタイミング解

析レポート 

– 

.pin.html 
html形式のポート属性レ

ポート 

– 

.power.html 
html形式の消費電力解析

レポート 

– 

.p 
インクリメンタル配置フ

ァイル 

インクリメンタル配置に

使用されます 

.pr 
インクリメンタル配置配

線ファイル 

インクリメンタル配置配

線に使用されます 

9.2 ファイルおよびフォルダの命名規則 

Gowinソフトウェアのフォルダとファイルの命名規則：名前に? “ / 

¥ < > * | :文字は使用できません。フォルダ名にはスペースは使用できませ

ん。ファイル名にはスペースが使用できますが、名前の先頭または末尾に

置くことはできません。 

Gowinソフトウェアのダイアログボックスにファイルのパス名を記

入する際に、上記の規則を満たしているかどうかが判断され、満たさない

場合はプロンプトウィンドウが表示されます。 

9.3 セキュリティ・ステートメント 

インストールと使用中、Gowinソフトウェアは、バックグラウンドで

ユーザーに関する情報を収集したり、ネットワーク・データ・ポートにア

クセスしたりせず、すべてのデータと情報はローカルに保持されます。ソ

フトウェアの自動更新も行われません。 
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